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• 位相シフト・フルブリッジ動作（降圧モード）
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1 概概要要

双方向DC-DCコンバータは、電力を双方向に伝達可能なアプリケーションで使用されます。ハイブリッド自動車

（HEV）および電気自動車（EV）では、通常動作中はこれらの双方向コンバータによって低電圧（12V）バッテリが充

電されますが（降圧モード）、高電圧（400V/600V）バッテリが非常に低いエネルギー/容量レベルまで放電したよう

な緊急の状況では、高電圧バッテリまたはバスを充電またはアシストします（昇圧モード）。標準的なシステムは、高

電圧（HV）側のフルブリッジ電源段と、それに対して絶縁された低電圧（LV）側のフルブリッジ段または電流供給

プッシュプル段から構成されています。

この実装では、LV側に配置されたTIの32ビット・マイコンTMS320F28035を使用して、両方向の電力の流れに対し

て閉ループ制御を実現しています。従来、これらのシステムでは、マイコンは監視または通信タスクだけを実行する

ように制限されてきました。高性能のマイコン・デバイスが利用できるようになったことで、マイコンはこれらのシステム

の制御ループを完結させながら、従来のマイコン機能も処理できるようになりました。デジタル電源制御への移行

は、以前はハードウェアで実装されていた機能がソフトウェアで実装されるようになったことを意味します。この能力

は、柔軟性に加えて、システムの強化および単純化にも貢献しています。これらのシステムは、さまざまな条件下で

電源段を最適に制御するための高度な制御戦略を実装しながら、システム・レベルのインテリジェンスを提供するこ

とで、動作モード間およびパルス幅変調（PWM）スイッチング・パターン間で安全かつシームレスな遷移を可能にし

ます。

このドキュメントでは、このような絶縁型双方向DC-DCコンバータのマイコン・ベースの実装について詳しく説明しま

す。位相シフト・フルブリッジ（PSFB）と同期整流によって、降圧モードでの400Vバス/バッテリから12Vバッテリへの

電力フローを制御し、またプッシュプル段によって、昇圧モードでの低電圧バッテリから高電圧バス/バッテリへの逆

電力フローを制御します。このデザインは、各モードで最大300Wの出力電力定格となっています。高電圧バスでの

電圧は400V～200Vの範囲内であり、低電圧バスでの電圧は13.5V～9Vの範囲内です。両方の動作モードに対し

て、電圧モード制御と平均電流モード制御が実装されています。各種のPWMスイッチング方式が実装され、スイッ

チング・モード間、および2つの動作モード間でシームレスな遷移が行われます。

1.1 基基本本動動作作

降降圧圧モモーードド

PSFBコンバータは、絶縁型トランスの1次側のフルブリッジが形成する4個のパワー・エレクトロニクス・スイッチ

（MOSFETまたはIGBTなど）と、2次側のダイオード整流器または同期整流用MOSFETスイッチによって構成され

ています。このトポロジによって、すべてのスイッチング・デバイスがゼロ電圧スイッチング（ZVS）でスイッチングでき

るため、スイッチング損失の低減とコンバータの効率向上につながります。

このような絶縁型トポロジでは、2次側に信号整流が必要となります。低出力電圧または高出力電流の定格を持つシ

ステムでは、同期整流を実装することで、ダイオード整流による損失を避けて最大の性能を達成できます。この構成

では、各種のスイッチング方式により2次側に同期整流を実装することで、変化する負荷条件に基づき最適な性能

を実現しています。

DC-DCコンバータ・システムは、電圧モード制御（VMC）、平均電流モード制御（ACMC）、またはピーク電流モード

制御（PCMC）などさまざまなモードで制御できます。同じ電源段を制御するためにこれらの異なる制御モードを実

装する際には、一般に制御回路の再設計とともに電源段センシング回路にいくつかの変更が必要となります。マイ

コン・ベースのシステムにより、追加の変更なし、または最小限の変更のみで、これらすべてのモードを同じデザイン

上で実験することができます。図 1に、位相シフト・フルブリッジの概略回路図を示します。MOSFETスイッチQ1、
Q2、Q3、Q4によって、T1トランスの1次側にフルブリッジが形成されます。Q1とQ4は、50%のデューティ・サイクル

で、互いに180度の位相差でスイッチングされます。Q2とQ3は、50%のデューティ・サイクルで、互いに180度の位

相差でスイッチングされます。フルブリッジのレグQ2–Q3用のPWMスイッチング信号は、レグQ1–Q4用の信号に対

http://www.tij.co.jp
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して位相シフトされています。この位相シフトの大きさによって、対角線上のスイッチ間のオーバーラップの度合いが

決まり、それによって転送されるエネルギーの量が決まります。D5とD6は2次側のダイオード整流を提供し、LoとCo
は出力フィルタを形成します。インダクタLRは、MOSFETの容量との共振動作のためにトランスのリーク・インダクタ

ンスをアシストし、ゼロ電圧スイッチング（ZVS）を容易にします。図 2に、図 1のシステムのスイッチング波形を示しま

す。

図図 1. 降降圧圧モモーードドのの電電源源段段

図図 2. 降降圧圧モモーードドののPWM波波形形

http://www.tij.co.jp
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昇昇圧圧モモーードド

同期整流スイッチは、昇圧モードではプッシュプル・スイッチとなります。このモードでは降圧モード出力インダクタを

電流源として使用できるため、このトポロジは電流給電のプッシュプル・コンバータとして動作できます。HV側のフル

ブリッジ・スイッチはオフに保持し、それらのボディ・ダイオードを整流に使用することができます。フルブリッジ・スイッ

チは、昇圧モードでのアクティブ整流に使用します。各プッシュプル・スイッチは、50%を超えるデューティ・サイクル

のPWM信号で駆動され、それぞれ互いに180度位相がずれています。

図図 3. 昇昇圧圧モモーードドのの電電源源段段

図図 4. 昇昇圧圧モモーードドののPWM波波形形

• t0 – t1：： この期間中は、Q5とQ6が同時にオンになります。トランスの低電圧巻線の誘導性エネルギーおよび昇

圧インダクタ（L1）の誘導性エネルギーが増加します。

• t1 – t2：： t1の時点でQ6がオフになり、LV側に蓄積された誘導性エネルギーがダイオードD1およびD3を通して

HV側に転送されます。

t2–t3期間中の動作はt0–t1と同じです。t3–t4期間中の動作はt1–t2と同様ですが、t3の時点でQ5がオフになり、

HV側でD2とD4が導通します。

この動作モードでは、HV側に転送されるエネルギーの量は、スイッチQ5およびQ6を駆動する信号のデューティ・サ

イクルによって決まります。位相制御される降圧モードと異なり、これはデューティ制御による動作です。

http://www.tij.co.jp
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1.2 双双方方向向DC-DC基基板板上上のの実実装装

図 5 に、双方向DC-DC基板上に実装された回路の概略ブロック図を示します。図 5に示されるシステムでは、4
個のMOSFETスイッチ（Q1–Q4）が絶縁型トランスのHV側のフルブリッジを形成し、センタータップ付きのLV側の2
個のMOSFETスイッチ（Q5–Q6）が降圧モードでは同期整流器として、昇圧モードではプッシュプル・スイッチとして

機能します。フルブリッジMOSFETのみを利用する昇圧モードの動作では、（整流用の）ボディ・ダイオードによって

システムの効率が大きく低下します。これは、ダイオードの逆方向回復が遅いことと、大きな電流が循環することによ

ります。この欠点を解消するために、各フルブリッジ・スイッチにはショットキー・ダイオード（D25–D28）がアンチ・パラ

レル構成で接続されています。フルブリッジMOSFETは適切なタイミングでオン/オフされることにより、昇圧モードで

同期整流を実現し、このモードでのシステム効率をさらに高めます。

図図 5. シシスステテムム・・ブブロロッックク図図

http://www.tij.co.jp
http://www-s.ti.com/sc/techlit/TIDUAI7.pdf
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制御アルゴリズムは、 C2000™マイコン（MCU）に実装されています。このマイコンは、帰還信号とPWM出力を使用

して電源段とやり取りします。コントローラは、このデザインのLV側に配置されます。絶縁型DC-DCシステムを設計

する際の重要な手順の1つは、絶縁境界の位置を基準としたコントローラの配置を決めることです。コントローラをLV
側に配置すると、複数のレールのあるシステムや、LV側で多くの信号や制御ループを処理するシステム、またはア

プリケーションで（LV側の）他のシステムと通信する場合などに有効です。

このシステムを各種動作モードで制御するには、高速で高効率の制御ループ計算とともに、複雑なPWM駆動波形

を生成する必要があります。この能力はC2000マイコン上でPWMモジュール、DACおよびスロープ補償ハードウェ

ア付きのアナログ・コンパレータ、および高効率の32ビットCPUと組み合わされた12ビットの高速ADCなど、高度な

オンチップ制御ペリフェラルによって可能になっています。以降のセクションでは、このソフトウェア・アルゴリズムに

ついて詳しく説明します。

1.3 シシスステテムムのの特特長長

この実装の主な特長を次に示します。

• HVバス電圧範囲： 200V DC～400V DC

• LVバス電圧範囲： 9V DC～13.5V DC

• 各方向に300W定格の出力動作

• LVバスの定格電流33A、HVバスの定格電流1.8A

• 降圧と昇圧モード間のシームレスで迅速な切り替え

• 位相シフト・フルブリッジ動作（降圧モード）

• 電流給電プッシュプル動作（昇圧モード）

• スイッチング周波数： 100kHz

• 出力インダクタ電流のVMCとACMC

• 複数のSRスイッチング方式

• 障害保護： 過電流、低電圧、過電圧

2 ハハーードドウウェェアアととリリソソーースス

図 6 に、ハードウェアの主要なコンポーネントを示します。

http://www.tij.co.jp
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図図 6. 双双方方向向DC/DC基基板板

表 1に、F28035 controlCARDとベース基板との間の主要な信号接続を示します。また、図 7に回路図の関連部分

を示しています。

表表 1. 主主要要なな信信号号接接続続

信信号号名名 説説明明 controlCARDへへのの接接続続

ePWM-1A フルブリッジ・スイッチQ2のPWM駆動 GPIO-00
ePWM-1B フルブリッジ・スイッチQ3のPWM駆動 GPIO-01
ePWM-2A フルブリッジ・スイッチQ1のPWM駆動 GPIO-02
ePWM-2B フルブリッジ・スイッチQ4のPWM駆動 GPIO-03
ePWM-4A 同期整流器/プッシュプル・スイッチQ6

のPWM駆動
GPIO-07

ePWM-4B 同期整流器/プッシュプル・スイッチQ5
のPWM駆動

GPIO-06

VLV-FB 低電圧バス – 電圧帰還 ADC-A0
ILV-FB 低電圧電流帰還（ジャンパJ2を接続） ADC-B3/COMP2A
ILV-FILT 大幅にフィルタリングされた低電圧電流帰還 ADC-B2
VHV-FB 高電圧バス – 電圧帰還 ADC-B1
IHV-FB トランスの高電圧巻線電流 ADC-A2/COMP1A
IHV-FILT 大幅にフィルタリングされたトランスの高電圧

巻線電流
ADC-A1

http://www.tij.co.jp
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この基板には実験用の各種ジャンパ・オプションがありますが、基板を動作させるにはそのうちのいくつかを接続す

る必要があります。接続が必要なジャンパは以下のとおりです。

• C:JPG1

• E:JPG1

• J2

• J5

• J6

• J7

• J8

• J10

• J11

• J12

• J13

• J15

• J16

• J19

http://www.tij.co.jp
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図図 7. ベベーースス基基板板ととcontrolCARDのの信信号号イインンタターーフフェェイイスス

http://www.tij.co.jp
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3 テテスストト結結果果

図 8 に、この基板をテストするためのテスト構成を示します。DC電源はバッテリからではなくHVおよびLVバスから供

給されています。150V、60Aのダイオード（GeneSiC Semiconductor、1N2130A）をLVバスへの低電圧電源に接

続し、600V、6Aのダイオード（Vishay、G1756）をHVバスへの高電圧電源に接続しています。LVバス上には電子

負荷が使用され、HVバス上には抵抗性負荷バンクが使用されています。

図図 8. テテスストト構構成成

以降の図に、この基板を使用したいくつかの結果を示します。

降降圧圧モモーードド

図図 9. 効効率率 対対 負負荷荷（（390 Vinででのの降降圧圧モモーードド））

http://www.tij.co.jp
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図図 10. 効効率率 対対 負負荷荷（（200 Vinででのの降降圧圧モモーードド））

図図 11. 効効率率 対対 出出力力電電圧圧（（390 Vinででのの降降圧圧モモーードド））

http://www.tij.co.jp
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図図 12. 効効率率 対対 出出力力電電圧圧（（390 Vinででのの降降圧圧モモーードド））

図図 13. 効効率率 対対 出出力力電電圧圧（（200 Vinででのの降降圧圧モモーードド））
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図図 14. 効効率率 対対 出出力力電電圧圧（（200 Vinででのの降降圧圧モモーードド））

昇昇圧圧モモーードド

図図 15. 効効率率 対対 負負荷荷（（12.4 Vin、、220 Voutででのの昇昇圧圧モモーードド））

http://www.tij.co.jp
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図図 16. 効効率率 対対 負負荷荷（（12.4 Vin、、300 Voutででのの昇昇圧圧モモーードド））

図図 17. 効効率率 対対 負負荷荷（（12.4 Vin、、390 Voutででのの昇昇圧圧モモーードド））
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図図 18. 効効率率 対対 負負荷荷（（9 Vin、、220 Voutででのの昇昇圧圧モモーードド））

図図 19. 効効率率 対対 負負荷荷（（9 Vin、、300 Voutででのの昇昇圧圧モモーードド））
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図図 20. 効効率率 対対 負負荷荷（（9 Vin、、390 Voutででのの昇昇圧圧モモーードド））

図図 21. 効効率率 対対 出出力力電電圧圧（（12.4 Vinででのの昇昇圧圧モモーードド））
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図図 22. 効効率率 対対 出出力力電電圧圧（（9 Vinででのの昇昇圧圧モモーードド））

モモーードド遷遷移移（（VLV、、VHV電電圧圧））

以降の図に、各種の動作条件でのモード遷移中に高電圧バスおよび低電圧バスで観測される電圧波形を示しま

す。新しいモードでの電圧設定点（モード変更コマンド後）は、そのバス上の前の電圧よりも高い点に設定されます。

たとえば、降圧モードから昇圧モードに遷移するときには、HVバスの電圧（VHV）が、前のVHV電圧よりも4V高い値に

設定されます。昇圧モードから降圧モードに遷移するときは、VLV電圧が前のVLV電圧よりも0.5V高い値に設定され

ます。結果として、モード遷移中の2つのバスには、予想どおりの電圧の低下または上昇が見られています。

図図 23. 降降圧圧かからら昇昇圧圧へへののモモーードド遷遷移移（（VHV = 225V、、2kΩ負負荷荷、、VLV = 12.6V、、3Ω負負荷荷））
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図図 24. 昇昇圧圧かからら降降圧圧へへののモモーードド遷遷移移（（VHV = 225V、、2kΩ負負荷荷、、VLV = 12.6V、、3Ω負負荷荷））

図図 25. 降降圧圧かからら昇昇圧圧へへののモモーードド遷遷移移（（VHV = 350V、、2kΩ負負荷荷、、VLV = 12.6V、、10Ω負負荷荷））
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図図 26. 昇昇圧圧かからら降降圧圧へへののモモーードド遷遷移移（（VHV = 350V、、2kΩ負負荷荷、、VLV = 12.6V、、10Ω負負荷荷））

図図 27. 降降圧圧かからら昇昇圧圧へへののモモーードド遷遷移移（（VHV = 266V、、667Ω負負荷荷、、VLV = 12.6V、、10Ω負負荷荷））
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図図 28. 昇昇圧圧かからら降降圧圧へへののモモーードド遷遷移移（（VHV = 266V、、667Ω負負荷荷、、VLV = 12.6V、、10Ω負負荷荷））

図図 29. 降降圧圧かからら昇昇圧圧へへののモモーードド遷遷移移（（VHV = 390V、、171W負負荷荷、、VLV = 12.4V、、154W負負荷荷））
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図図 30. 昇昇圧圧かからら降降圧圧へへののモモーードド遷遷移移（（VHV = 390V、、171W負負荷荷、、VLV = 12.4V、、154W負負荷荷））

モモーードド遷遷移移（（拡拡大大））

以降の図には、各種動作条件でのモード遷移中にメインの電源トランスT2の高電圧巻線で観測された電圧波形、

および対角線上に配置されたフルブリッジ・スイッチQ2およびQ4のPWM駆動信号について、拡大図を示します。

条件

図図 31. 降降圧圧かからら昇昇圧圧へへののモモーードド遷遷移移（（VHV = 390V、、19W負負荷荷、、VLV = 12.4V、、307W負負荷荷））
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図図 32. 昇昇圧圧かからら降降圧圧へへののモモーードド遷遷移移（（VHV = 390V、、19W負負荷荷、、VLV = 12.4V、、307W負負荷荷））

図図 33. 降降圧圧かからら昇昇圧圧へへののモモーードド遷遷移移（（VHV = 390V、、171W負負荷荷、、VLV = 12.4V、、154W負負荷荷））
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図図 34. 昇昇圧圧かからら降降圧圧へへののモモーードド遷遷移移（（VHV = 390V、、171W負負荷荷、、VLV = 12.4V、、154W負負荷荷））
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4 降降圧圧モモーードド（（位位相相シシフフトト・・フフルルブブリリッッジジ）） – 機機能能説説明明

4.1 電電圧圧モモーードド制制御御

VMC実装では、各レグのスイッチを固定（50%）デューティ・サイクルおよび固定周波数の相補型PWM信号で駆動

します。図 35に示すように、コントローラは、ブリッジの1つのレグのスイッチを駆動するPWM信号を直接駆動し、位

相シフトを制御します。位相シフトは、ブリッジのもう一方のレグのスイッチを駆動する信号を基準に制御します。この

位相シフトによって、図 37に示すように、対向するスイッチ間のオーバーラップの大きさが決まります。対向スイッチ

間のオーバーラップが大きいほど、入力電圧がトランスの高電圧巻線に印加される時間が長くなり、低電圧側に転

送されるエネルギーが増加します。コントローラは、2つのフルブリッジ・レグを駆動するPWM信号間の位相シフトを

直接制御してこのエネルギー転送を制御することにより、出力のレギュレーションを実現します。この位相シフトが、

制御パラメータです。VMC実装では、時間の経過に伴う磁束の不均衡によって起こりうるトランスの飽和を避けるた

めに、トランスの高電圧巻線にDCブロッキング・コンデンサを含める必要があります。ジャンパJP1は、デフォルトで

は接続されません。PCMCを実装する場合は、適切な定格のジャンパをJP1に取り付けることができます。

図図 35. VMCののブブロロッックク図図

http://www.tij.co.jp
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4.2 出出力力イインンダダククタタ電電流流のの平平均均電電流流モモーードド制制御御

電源アプリケーションでの標準的なACMC実装は、外側の電圧制御ループと内側の平均電流ループから構成され

ます。PSFB電源段に対する内側の平均電流ループは、高電圧巻線の平均電流を制御します。バッテリ充電アプリ

ケーションでは、1つの平均電流ループを使用してACMCモードのバッテリ充電電流を制御し（定電流充電）、必要

に応じて定電圧充電用にVMCモードへと切り替えます。ACMCの実装は、波形生成および電源段制御については

VMCの実装と同様です。図 36に示すように、コントローラは、ブリッジの1つのレグのスイッチを駆動するPWM信号

を直接駆動し、位相シフトを制御します。位相シフトは、ブリッジのもう一方のレグのスイッチを駆動する信号を基準

に制御します。VMCモードと同様に、コントローラは、2つのフルブリッジ・レグを駆動するPWM信号間の位相シフト

を直接制御してエネルギー転送を制御することにより、出力のレギュレーションを実現します。図 37に、降圧モード

動作中のさまざまな波形を示します。

図図 36. ACMCののブブロロッックク図図

http://www.tij.co.jp
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図図 37. 降降圧圧モモーードドのの波波形形

4.3 ゼゼロロ電電圧圧ススイイッッチチンンググままたたはは低低電電圧圧ススイイッッチチンンググ

PSFB DC-DCコンバータは、回路内の寄生要素を使用して、MOSFETスイッチをオンにする前に印加されている

電圧がゼロであるようにし、ソフトなスイッチングを実現します。このように電圧をかけないことで、ハードなスイッチン

グに伴うスイッチング損失を減らすことができます。

Q2–Q3レグのスイッチに対するスイッチング遷移によって、電力転送期間が終了します。このレグは、アクティブ-
パッシブ・レグと呼ばれます。このレグのスイッチに対して遷移が発生すると、高電圧巻線の電流は、対応するPWM
スイッチング・サイクルの半分の期間にわたって最大値に近くなります。反射された負荷電流が、この期間中の高電

圧巻線回路の循環エネルギーの補助となるため、このレグのスイッチにかかる電圧を0Vに近づけることが可能にな

ります。スイッチに対するZVSは、このQ2–Q3レグで幅広い負荷範囲にわたって実現可能です。負荷が小さくなる

と、ZVSを実現またはそれに近づくためにデッドタイムを長くする必要があります。

http://www.tij.co.jp
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Q1–Q4レグのスイッチに対するスイッチング遷移によって、電力転送期間が開始されます。このレグは、パッシブ-
アクティブ・レグと呼ばれます。これらの遷移中は、高電圧巻線の電流が減少します。高電圧巻線電流はゼロ電流

値を横切り、方向が変化します。電流がゼロになって方向が変わることで、ZVSのために利用できるエネルギーが小

さくなります。低負荷状態で動作する場合は、これらのスイッチがオンになる前に、スイッチにかかる電圧がゼロにな

らなくてもかまいません。これらにかかる電圧がLVSを実現するための最小値であれば、これらのスイッチを一度に

オンにすることで、スイッチング損失を最小限に抑えることができます。負荷が変化すると、LVSを実現するためにス

イッチをオンにするタイミングが変化するため、Q2–Q3レグのスイッチと同様なデッドタイム調整が必要になります。

4.4 同同期期整整流流

同期整流器は、任意の時点で次の3つのモードのいずれかで動作できます。

• モモーードド0：： これは古典的なダイオード整流モードであり、同期整流器をオフに保持することで実現されます。これ

は、同期整流で得られる電力の節減よりも同期整流器のスイッチング損失の方が大きいような非常に低負荷の

動作に対して有用です。

• モモーードド1：： このモードでは、同期整流器が理想的なダイオード動作をエミュレートします。このモードは、非常に

低い負荷～比較的低い負荷での動作時、一般にはバースト・モードの使用時に便利です。このモードでは、対

応する対向フルブリジ・スイッチのペアを駆動するPWM信号が互いにオーバーラップするときにだけ、同期整流

器のMOSFETがオンになります。

• モモーードド2：： 他のすべての負荷条件に対して有用です。このモードでは、対応する対向フルブリジ・スイッチとは反

対側のペアを駆動するPWM信号が互いにオーバーラップするときにだけ、同期整流器のMOSFETがオフにな

ります。

図 37 に、これらのモードで同期整流器スイッチを駆動するために生成される波形を示します。システムの安全な動

作を確保するために、大きな負荷過渡事象や急激な位相シフト変化コマンド時であっても、PWM出力にグリッチや

異常なしでシームレスなモード遷移を実現できるようにすることが重要です。

5 降降圧圧モモーードド – ソソフフトトウウェェアアのの概概要要

5.1 ソソフフトトウウェェアア制制御御フフロローー

Bi-dir_Buckプロジェクトでは、Cバックグラウンド/ASM-ISRフレームワークを使用します。Cバックグラウンド/ASM-
ISRフレームワークは、アプリケーションのメインのサポート・プログラムとしてCコードを使用し、すべてのシステム管

理タスク、意思決定、インテリジェンス、およびホストとのやり取りを実行します。アセンブリ・コードは、すべての重要

な制御コードを実行する割り込みサービス・ルーチン（ISR）のみに厳密に制限されています。これには一般に、

ADCの読み取り、制御用の計算、およびPWMとDACの更新が含まれます。図 38に、このプロジェクトの全般的なソ

フトウェア・フローを示します。
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図図 38. 降降圧圧モモーードドののソソフフトトウウェェアア・・フフロローー

このプロジェクトでは、以下の主要なフレームワークCファイルが使用されます。

• Bi-dir-Main.c – このファイルはアプリケーションを初期化、実行、および管理します。

• Bi-dir-DevInit_F2803x.c – このファイルは、マイコンの1回のみの初期化および構成を管理し、クロック、PLL、
GPIOの設定などの機能を含みます。

ISRは、以下のファイルから構成されます。

• Bi-dir-DPL-ISR.asm – このファイルは、時間が重要となる制御タイプ・コードをすべて含んでいます。このファイ

ルには初期化セクション（1回実行）とランタイム・セクション（PWMスイッチング周波数で実行）が含まれていま

す。

Power Libraryの関数（モジュール）は、このフレームワークから呼び出されます。

ライブラリ・モジュールにはCコンポーネントとアセンブリ・コンポーネントの両方が含まれる場合があります。表 2に、

このプロジェクトのライブラリ・モジュールを示します。Cモジュール名および対応するアセンブリ・モジュール名を記

載しています。

表表 2. ラライイブブララリリ・・モモジジュューールル

C構構成成関関数数 ASM初初期期化化ママククロロ ASMラランンタタイイムム・・ママククロロ

DAC_Cnf.c
ADC_SOC_Cnf.c ADCDRV_4CH_INIT m,n,p,q ADCDRV_4CH m,n,p,q
PWM_PSFB_VMC_SR_Cnf.c PWMDRV_PSFB_VMC_SR_INIT m,n,p PWMDRV_PSFB_VMC_SR m,n,p

CNTL_2P2Z_INIT n CNTL_2P2Z n
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図 39 に制御ブロックを示します。

図図 39. ソソフフトトウウェェアア・・ブブロロッックク

図 39では、濃い青色のブロックがC2000マイコン上のハードウェア・モジュールを表しています。青色のブロックは、

これらのモジュール用のソフトウェア・ドライバです。黄色のブロックは、制御ループ用のコントローラ・ブロックです。

ここでは2極/2ゼロのコントローラを使用していますが、PI/PIDや3極/3ゼロなど、このアプリケーションに実装可能な

他の種類のコントローラも使用できます。図 40に示すように、このようなモジュール型のライブラリ構造によって、シス

テム全体のソフトウェアの流れが見やすく、理解しやすくなっています。この構造により、各種の機能の使用、追加、

削除が簡単になります。このプロジェクトでは、段階的ビルドのアプローチを実装することで、これらのメリットを示して

おり、これについては 5.2でさらに詳しく説明します。
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図図 40. 制制御御フフロローー

システムは、1つの電圧/電流帰還ループによって制御されます。図 40には、制御ブロックの実行レートも示されて

います。たとえば、電圧コントローラは100kHzのレート（PWMスイッチング周波数と同じ）で実行されます。図 40
で実装されている制御について次に説明します。

センスされた出力電圧または電流（Adc_Vfbout/Adc_Iout）は、VMCモードでは電圧リファレンス・コマンド（Vref）の
スルー・バージョン（VfbSetSlewed）と比較され、ACMCモードでは電流リファレンス・コマンド（Iref）と比較されま

す。コントローラの出力によって、フルブリッジの2つのレグを駆動するPWM信号間の位相シフトを直接制御します。

それによって、出力電圧のレギュレーションに使用されるフルブリッジの2つのレグ間の位相オーバーラップの大きさ

が決まります。dbAtoP_legおよびdbPtoA_legの値は、それぞれフルブリッジのアクティブ-パッシブ・レグおよびパッ

シブ-アクティブ・レグに対するデッドバンドの値を決定します。これらの値を使用して、負荷範囲全体にわたる

ZVS/LVSを実現します。

5.2 段段階階的的ビビルルドド

このプロジェクトは、2つの段階的ビルドに分かれています。このアプローチによって、基板およびソフトウェアについ

て理解し習熟しやすくなります。また、このアプローチは、基板のデバッグやテストにも適しています。表 3に、ビル

ド・オプションを示します。特定のビルド・オプションを選択するには、表 3に示されるように、Bi-dir-Settings.hファイ

ルでマクロINCR_BUILDを対応するビルド選択に設定します。ビルド・オプションを選択したら、rebuild-allコンパイ

ラ・オプションを選択して、プロジェクト全体をコンパイルします。ビルド・オプションの実行については、 6で詳しく説

明します。
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表表 3. 降降圧圧モモーードドのの段段階階的的ビビルルドド・・オオププシショョンン

オオププシショョンン 説説明明

INCR_BUILD = 1 ADC帰還を使用した開ループPSFB駆動（PWM駆動回路およびセンシング回路をチェック）

INCR_BUILD = 2 閉ループ（VMC/ACMCモードでのフルPSFB）

6 降降圧圧モモーードド – 段段階階的的ビビルルドドのの実実行行手手順順

メイン・ソース・ファイル、ISRアセンブリ・ファイル、およびシステムを起動するCフレームワーク用のプロジェクト・ファ

イルは、次のディレクトリに格納されています（最新バージョンのソフトウェア・パッケージを使用してください）。

• ..\controlSUITE\development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\Buck_Mode

図 7に示されている6V～13.5VのDC電源および400Vの負荷は、降圧モードの動作には必要ありません。

WARNING
基基板板上上ににはは高高電電圧圧がが印印加加さされれてていいまますす。。ララボボ環環境境でで経経験験をを積積んんだだ電電源源技技術術
者者ののみみがが基基板板をを取取りり扱扱うう必必要要ががあありりまますす。。ここのの基基板板をを安安全全にに評評価価すするるににはは、、適適
切切なな絶絶縁縁型型のの高高電電圧圧DC電電源源をを使使用用ししててくくだだささいい。。基基板板ににDC電電源源をを印印加加すするる
前前にに、、電電圧圧計計おおよよびび適適切切なな抵抵抗抗性性負負荷荷ままたたはは電電子子負負荷荷をを出出力力にに接接続続すするる必必
要要ががあありりまますす。。電電源源がが印印加加さされれてていいるる間間はは、、基基板板にに触触れれなないいででくくだだささいい。。

Buck_Modeソフトウェア内のサンプルをビルドして実行する方法の手順を以下に示します。

6.1 ビビルルドド1: ADC帰帰還還をを使使用用ししたた開開ルルーーププ・・チチェェッックク

目目的的

このビルドの目的は、システムの開ループ動作を評価し、PWMおよびADCドライバ・モジュールを検証し、基板上

のMOSFETドライバ回路とセンシング回路を検証し、 Code Composer Studio™（CCS）の動作に習熟することで

す。このシステムは開ループで動作しているため、ADCでの測定値はこのビルドでの計測にのみ使用されます。こ

のセクションでは、プロジェクトのビルドと実行に必要な手順について説明します。

概概要要

ビルド1のソフトウェアは、位相シフト・フルブリッジPWMドライバ・モジュールをすばやく評価できるように構成されて

います。これは、オシロスコープで出力波形を表示し、CCS上で位相を対話的に調整しながら、出力電圧に対する

位相変化の影響を観測することで行います。ADCドライバ・モジュールの評価は、ADCでサンプリングされたデータ

を監視ビューで表示することによって行います。
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PWMおよびADCドライバのマクロのインスタンス化は、_DPL_ISRの内部で実行されます。図 41に、このビルドの

各ブロックを示します。ePWM1AおよびePWM1BはそれぞれQ2およびQ3フルブリッジ・スイッチを駆動し、

ePWM2AおよびePWM2BはそれぞれQ1およびQ4フルブリッジ・スイッチを駆動します。ePWM4Aおよび

ePWM4Bは、それぞれQ6およびQ5同期整流器スイッチを駆動します。

図図 41. ビビルルドド1ののソソフフトトウウェェアア・・ブブロロッックク

これらのPWM信号は、100kHzの周波数（つまり、10µsの周期）で生成する必要があります。マイコンが60MHzで動

作している場合、ePWM1、ePWM2、またはePWM4の時間ベース・カウンタの1カウントは16.667nsに対応します。

ePWM1、ePWM2、またはePWM4の時間ベース・カウンタの1カウントが16.667nsに対応するということは、10µs
のPWM周期が時間ベース・カウンタ（TBCNT1、TBCNT2、およびTBCNT4）の600カウントに相当することを意味し

ます。ePWM1およびePWM2モジュールはアップカウント・モードで動作するよう構成されている一方、ePWM4
はアップダウン・カウント・モードで動作します。ePWM1AとePWM1Bの出力は50%のデューティ・サイクルで動作

し、相補的になっています。同様に、ePWM2AとePWM2Bの出力も50%のデューティ・サイクルで動作し、相補的

になっています。ePWM2の時間ベース・カウンタの位相は、ePWM1の位相を基準にして動的に変化させることが

できます。図 37に、これらのPWM波形を示します。

PWMドライバ・モジュールへの位相入力によって、PWM1およびPWM2時間ベース・カウンタ間の位相シフトの大き

さが決まります。この位相値によって、フルブリッジの対角線上に配置されたスイッチ・ペアを駆動するPWM信号間

のオーバーラップの大きさが制御されます。位相が増加するとオーバーラップが大きくなり、2次側に転送されるエネ

ルギーの量が増加します。TBPHS2の値は、入力位相コマンドから得られます。
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表 4 に、TBPRDの値が599のときのTBPHS2の値の例を示します。

表表 4. 位位相相値値

位位相相（（Q24）） TBPHS2 = (位位相相× TBPRD ÷ 225) 位位相相シシフフトト（（度度））

2097152d 37 22.5
8388608d 149 90
16776704d 299 180

フルブリッジの対角線上の各スイッチ・ペアは、1回のPWM周期内で1回オーバーラップします。最大のオーバー

ラップが発生するのは、位相シフトが約180度のときです。ISRアセンブリは、ePWM1のZRO（TBCNT1 = 0）イベン

トによってトリガされます。このISRで、制御ドライバのマクロが実行され、TBPHS2およびTBPHS4レジスタが更新さ

れます。

ADC入力がどこでサンプリングされるかを考慮すると、ADC入力信号の完全性が重要になります。これは、ADC
がアナログ・ドメインとデジタル・ドメイン間のインターフェイスとして機能するためです。電源段でスイッチをオン/オフ

すると、このときにセンスされる信号にノイズや外乱が生じる場合があります。このノイズがADC入力上に現れないよ

うに、これらの信号上にはフィルタが用意されていますが、このような外乱を避けるために、すべてのADC入力を一

度にサンプリングしてください。

センシングされた出力電圧は、スイッチング・サイクル内で、出力電圧値がその平均値に近くなる適切な点でサンプ

リングする必要があります。ADC入力信号を一度にサンプリングすることで、できる限りノイズの少ないサンプルを取

得できるほか、平均の出力電圧をサンプリングできます。フルブリッジでは、2つの対向スイッチ間のオーバーラップ

の中点でサンプリングを行います（オーバーラップとは、両方のスイッチが同時にオンになっている時間を指しま

す）。つまり、MOSFETのスイッチングからできる限り離れたタイミングでサンプリングします。MOSFETのスイッチン

グからできる限り離れたタイミングでサンプリングすることにより、ADC結果にスイッチング・ノイズが反射されるのを避

けることができます。C2000デバイスのADCおよびPWMモジュールは柔軟性が高いため、ADC変換を精密かつ柔

軟にトリガできます。ADCドライバ・モジュールを使用して12ビットのADC結果を読み取り、それをQ24値に変換しま

す。各PWMサイクル中に、PWM2 SOCA（変換Aの開始）によって5回のADC変換がトリガされます。

保保護護

このプロジェクトのシャットダウン・メカニズムでは、オンチップのアナログ・コンパレータ1を使用して、トランスの高電

圧巻線電流に対する過電流保護を実装しています。基準トリップ・レベルは内部の10ビットDACを使用して設定さ

れ、このコンパレータの反転端子に供給されます。コンパレータの出力は、センスされた電流が設定制限値を上回

るときにePWM1、ePWM2、およびePWM4にワンショットのトリップ・アクションを生成するよう構成されています。

C2000デバイスのトリップ・メカニズムの柔軟性により、異なるトリップ・イベントに対して異なるアクションを実行するこ

とが可能になっています。このプロジェクトでは、電源段を保護するために、ePWM1A、ePWM1B、ePWM2A、
ePWM2B、ePWM4A、およびePWM4Bの出力が直ちにLowになります。これらの出力は、デバイスのリセットが実

行されるまでの間、Lowに保持されます。低電圧および過電圧保護は実装されていませんが、完全な双方向プロ

ジェクト（Bi_Directional_Full）では実装されています。

6.1.1 手手順順

CCSをを起起動動しし、、ププロロジジェェククトトをを開開くく

このビルドをすばやく実行するには、次の手順に従います。

1. 2で示したとおりに、基板上のすべてのジャンパが正しく取り付けまたは取り外されていることを確認します。

2. F28035 controlCARDを100ピンDIMMコネクタに挿入します。

3. 12V DCのベンチ電源をTP10とTP11の間に正しい極性で接続します。

4. 400VのプログラマブルDC電源を400V入力コネクタに接続し、12V負荷を12Vコネクタに接続します（この負荷
は基板の定格を超えないようにしてください）。
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5. PCと基板の間にUSB-B/USB-Aケーブルを接続します。

注注: この時点では、どの電源もオンにしないでください。

6. 基板をJTAG接続でテストするのが初めてである場合は、xds100v2-FT_Prog_v2.2.zipファイル内の
program_ftdi.batファイルを実行して、基板上のFTDIチップをプログラミングします。

7. Code Composer Studio（CCSv5以降）を起動します。

8. Code Composer Studioを画面上で最大化します。

9. Welcome画面が表示された場合は閉じます。

注注: プロジェクトには、マイコンのハードウェアで実行できる実行形式出力ファイル（.out）を開発するため
に必要な、すべてのファイルとビルド・オプションが含まれています。

10. メニュー・バーで、“Project” → “Import Existing CCS/CCE Eclipse Project”の順にクリックします。

11. ..\controlSUITE\ development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\Buck_Mode
ディレクトリを選択します。

12. “Projects”タブで、Bi-dir_Buckにチェックマークが付いていることを確認します。

13. “Finish”をクリックします。

注注: このプロジェクトは、すべての必要なツール（コンパイラ、アセンブラ、リンカ）を使用してビルドを実行
します。

14. 左側の“Project”ウィンドウで、プロジェクトの左側にある“+”をクリックします。図 42を参照してください。
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図図 42. 降降圧圧モモーードドののCCSププロロジジェェククトト・・ウウィィンンドドウウ

15. メイン・ファイル内にあるビルド2の初期化コードを見つけます。

16. コードの内容を確認します。（このコードによって、すべての制御ブロックが設定、初期化され、制御フロー内で
接続されます。）

デデババイイススのの初初期期化化、、メメイインン、、おおよよびびISRフファァイイルル

注注: ソース・ファイルには一切変更を加えないでください。

1. Bi-dir-DevInit_F2803x.cをダブルクリックします。

2. システム・クロック、ペリフェラル・クロックのプリスケール、およびペリフェラル・クロックのイネーブルが設定されて
いることを確認します。

3. 共有GPIOピンが設定されていることを確認します。

4. Bi-dir-Main.cをダブルクリックします。

5. DeviceInit()関数の呼び出し、各段階的ビルド・オプションのコード、ISR初期化、およびバックグラウンドfor(;;)
ループを表示します。

6. メイン・ファイル内にあるビルド1のコードを見つけます。

7. コードの内容を確認します。
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注注: このビルド1に固有のコードで、PWMDRV_PSFB_VMC_SRブロックが接続および初期化されます。

8. Bi-dir-DPL-ISR.asmをダブルクリックします。

注注: _DPL_Initおよび_DPL_ISRセクションで、それぞれ初期化およびランタイム用のPWMおよびADC
ドライバ・マクロのインスタンス化が実行されます。確認を終えたファイルは閉じてかまいません。

ププロロジジェェククトトののビビルルドドととロローードド

1. Bi-dir-Settings.hファイルで、段階的ビルド・オプションとして1を選択します。

注注: 以前に別のオプションをビルドした場合は、プロジェクト名を右クリックして、“Clean Project”をクリック
します。

2. “Project” → “Build All”の順にクリックします。

3. 12V DCベンチ電源をオンにします。

4. “Debug”ボタンをクリックします。

注注: ビルド1のコードがコンパイルされてロードされます。

F28035ターゲット構成を作成するか、またはF28035.ccxmlファイルから構成をコピーするには、次の手順に従いま

す。

1. “Target Configurations”ウィンドウで、F28035.ccxmlを右クリックします。

2. “Debug”ウィンドウでデバイスの名前を右クリックして、デバイスを接続します。

3. “Run”→“Load”→“Load Program”の順に選択します。

4. Buck_Mode\F2803x_Flash\Bi-dir_Buck.outを選択して、コードをロードします。

注注: 右上の“CCS Debug”アイコンに、プログラムが“Debug Perspective”ビューであると表示されている
必要があります。

5. main()の先頭でプログラムを停止します。
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デデババッッググ環環境境ウウィィンンドドウウ

コードのデバッグ中に、ローカル変数およびグローバル変数を監視します。CCSのメモリ・ビューおよび監視ビュー

を使用できます。CCSでは、時間ドメインと周波数ドメインのプロットを作成できます。波形はグラフ・ウィンドウを使用

して表示できます。

1. メニュー・バーで、“View” → “Scripting console”をクリックします。

2. スクリプト・コンソールの“Open File ( )”コマンドを使用して、プロジェクト・ディレクトリから
AddWatchWindowVars.jsファイルを開きます。

これにより、“Expressions”ウィンドウの各項目が設定されます。“Expressions”ウィンドウの外観については、図 43
を参照してください。

注注: いくつかの変数はメイン・コードのこの時点では初期化されておらず、不定の値が格納されています。

OC_FaultFlgがセットされている場合は、過電流状態によってPWM出力がシャットダウンされることを示しています。

PWM出力は、デバイスがリセットされるまでこの状態に保持されます。Ipri_trip変数は、オンチップ・コンパレータ1
に対する内部10ビットDACの基準レベルを設定します。これはQ15値です。

図図 43. 降降圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド1

リリアアルルタタイイムム・・エエミミュュレレーーシショョンンのの使使用用

リアルタイム・エミュレーションは、マイコンの動作中にCCS内のウィンドウを最大10Hzのレートで更新できるようにす

る特別なエミュレーション機能です。このエミュレーションにより、グラフや監視ビューが更新され、また、マイコンの動

作に影響を与える監視またはメモリ・ウィンドウ内の値を変更することができます。このエミュレーションは、制御パラ

メータをその場で調整する際に便利です。

リアルタイム・モードをイネーブルにするには、次の手順に従います。

1. 水平ツールバー上のボタンにマウス・ポインタを置きます。

2. をク
リックします。
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注注: メッセージ・ボックスが表示されたら、“YES”を選択して、デバッグ・イベントをイネーブルにします。こ
れにより、ステータス・レジスタ1（ST1）のビット1（DGBMビット）が0に設定されます。

DGBMは、デバッグ・イネーブル・マスク・ビットです。DGBMビットが0に設定されているときは、メモリ
およびレジスタの値をホスト・プロセッサに渡して、デバッガ・ウィンドウを更新できます。

開いているまたは更新中のウィンドウや変数の数が多すぎるときには、連続的に更新を実行すると、エミュレーショ

ン・リンクの帯域幅が限られているために、更新頻度が遅くなる場合があります。“Expressions”ウィンドウの更新レー

トを変更するには、次の手順に従います。

1. “Expressions”ウィンドウで を右クリックします。

2. “Continuous Refresh Interval…”を選択します。

3. 連続更新間隔の値を変更します。（通常、これらのテストには、1000msのレートで十分です。）

4. 監視ビューの をクリックします。

ココーードドのの実実行行

1. ツールバーの“Run”をクリックします。

2. 監視ビューで位相の変数を0.015625（Q24）に設定します。

注注: この変数は、PWMDRV_PSFB_VMC_SRモジュールへの位相シフト・コマンドを規定します。位相
に0.005未満の値は使用しないでください。

3. DC出力のPSFBシステムに12V出力で約3A～6Aの電流が流れるように、適切な抵抗性負荷を適用します。

注注: TIでは、絶縁型DC電源を使用して、400VのDC入力を基板に供給することを推奨します。

4. J1、J2の入力に390V DCの電源を供給します。

5. 監視ビューで位相を大きな値（0.1など）に設定して、位相コマンドを増加させます。

6. 出力電圧の上昇を観測します。

注注: 電圧が基板の定格を超えないようにしてください。

特定の位相値で動作しているときには、負荷を急激に減少させると出力電圧が急上昇する場合があ
ります。ビルド1での動作時には、負荷を急に変化させたり位相コマンドを大幅に増加させたりしない
ようにしてください。

7. 異なる位相値に対して、監視ビューで異なるADC結果を観測します。
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図 44 は、入力電圧が約390V、負荷が12V出力で約6A（2Ω）のときの0.38（Q24）の位相コマンドに対するシス

テム動作の監視ビューを示しています。

図図 44. 降降圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド1（（ラランンタタイイムム））

8. 監視ビューからSR_mode変数を0、1、または2に変更して、同期整流器の動作モードを変更します。（デフォル
トでは、同期整流器はモード2で動作します。）

9. 異なるSRモードで、消費される入力電流の大きさの変化および出力電圧の変化を観測します。

10. 同期整流器スイッチを駆動するPWM波形をプローブします。

注注: 非常に低い負荷で動作しているときや、出力電圧が非常に低い（6V未満）ときには、SRモードを変
更しないでください。そのような場合は、デフォルトのSRモード2を使用してください。

11. いくつかの異なる位相値を試します。

12. 対応するADC結果を観測します。

注注: 位相は小さい間隔で増加させます。常に出力電圧を慎重に観測してください。電圧が基板の定格を
超えないようにしてください。

オシロスコープを使用して、PWMゲート駆動信号、入力電圧、電流、出力電圧などの波形をプロー
ブできます。

この絶縁型DC-DCコンバータに対してこれらの高電圧および高電流をプローブする際には、安全性
に関する適切な予防措置を実施し、適切な接地要件を考慮してください。

リアルタイム・モードでマイコンを完全に停止させるには、次の手順に従います。

1. 400V DC入力をオフにし、数秒間待ちます。

2. ツールバーの“Halt”をクリックして、プロセッサを停止します。

3. をクリックして、マイコンのリアルタイム・モードを終了します。

4. マイコンをリセットします。
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6.2 ビビルルドド2：： 閉閉電電圧圧ルルーーププ（（フフルルPSFB））

目目的的

このビルドの目的は、CCS環境から完全なPSFBプロジェクトの動作を検証することです。

概概要要

図 45 に、このビルドの各ソフトウェア・ブロックを示します。PWMおよびADCドライバ・ブロックは、ビルド1の場合と

同様に使用されます。電圧/電流ループには、2極/2ゼロのコントローラを使用します。アプリケーションの制御ルー

プ要件に応じて、PI、3極/3ゼロなど、他のコントローラ・ブロックも使用できます。図 45に示されるとおり、電圧ルー

プ・ブロックは100kHzで実行されます。CNTL2P2Zは、IIRフィルタ構造から実現される2次補償回路です。この機

能は、すべてのペリフェラルから独立しており、CNF関数の呼び出しを必要としません。

図図 45. ビビルルドド2ののソソフフトトウウェェアア・・ブブロロッックク

変更する5つの係数は、構造体CNTL_2P2Z_CoefStruct1の要素として格納されています。この構造体の他の要素

によって、コントローラの出力がクランプされます。システムで複数のループが必要な場合、CNTL_2P2Zブロックは

複数回インスタンス化することができます。各インスタンスには、それぞれ個別の係数のセットを使用できます。試行

錯誤を通して5つの係数を直接独立に操作することはほぼ不可能であり、数学的な分析や、 MATLAB®、 Mathcad
®などの支援ツールが必要となります。これらのツールは、ボード・プロットや根軌跡など、位相マージンやゲイン・

マージンを決定するための機能を提供します。

ループ調整をシンプルに保ち、複雑な計算や分析ツールを不要にするために、TIでは、B0、B1、B2、A1、A2に対

して、より直観的な係数ゲインP、I、Dをマッピングすることで、係数選択問題の自由度を5から3へと減らしました。こ

の自由度の減少により、P、I、Dがそれぞれ独立して段階的に調整されます。これらのマッピングの式を以下に示し

ます。
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補償回路ブロック（CNTL_2P2Z）は2つの極と2つのゼロを持ち、一般的なIIRフィルタ構造に基づいています。この

ブロックには、1つのリファレンス入力と1つの帰還入力があります。帰還は、VMCモードの選択時はセンスされた出

力電圧（Adc_Vfbout）であり、ACMCモードの選択時はセンスされた出力電流（Adc_Iout）です。この選択は、Bi-
dir-Settings.hファイルから実行できます。コントローラへのリファレンス入力は、モード選択に基づいて、出力電圧リ

ファレンス・コマンド（Vref）のスルー・バージョン（VfbSetSlewed）、またはリファレンス出力インダクタ電流コマンド

（Iref）です。 伝達関数は式 1で与えられます。

(1)

PIDコントローラの再帰形式は式 2で与えられます。

(2)

ここで、式 3、式 4、式 5が成り立ちます。

(3)

(4)

(5)

また、Zドメイン伝達関数形式は式 6のようになります。

(6)

これを一般的な形式と比較すると、PIDはCNTL_2P2Z制御の特殊なケースであり、式 7が成り立つ場合です。

(7)

これらのP、I、およびD係数は、Pgain、Igain、およびDgainです。これらのP、I、およびD係数はQ26形式で使用さ

れます。CCS監視ビューからの調整を単純化するために、これらの3つの係数をさらに0～999の値へと変換します

（Pgain_Gui、Igain_Gui、Dgain_Gui）。また、ループ・パラメータも、外部の数学ツール（MATLAB、Mathcadなど）

から得られる調整済みの値に基づいて、直接変更できます。ループ係数は、I5Q10形式の変数b2_Gui、b1_Gui、
b0_Gui、a2_Gui、a1_Guiを使用して直接変更でき、その後で、2P2Zコントローラ用に5個のQ26係数へと変換され

ます。

このプロジェクトでは、実行中に係数を簡単に切り替えて、両方のループ調整方法を簡単に評価できます。この切り

替えは、単にGUI上で2P2Z(On)/PID(Off)ボタンをクリックするか、またはCCSから監視ビュー上でpid2p2z_GUI
変数を0または1に変更することによって行えます。このプロジェクトでは、GUI環境からのPIDベースのループ調整

（pid2p2z_GUI = 0）を使用しています。pid2p2z_GUIを1に変更する前に、b2_Gui、b1_Gui、b0_Gui、a2_Gui、
およびa1_Gui変数に信頼できる係数値がプログラミングされていることを確認してください。

注注: このプロジェクトには、有効なb2_Gui、b1_Gui、b0_Gui、a2_Gui、およびa1_Guiパラメータ値が含
まれていません。TIでは、pid2p2z_GUI = 0に保持することで、デフォルトのP、I、Dベースのループ
を使用することを推奨します。

6.2.1 手手順順

ププロロジジェェククトトののビビルルドドととロローードド

構成済みの作業環境を使用してこのビルドをすばやく実行するには、次の手順に従います。

1. 2で示したとおりに、基板上のすべてのジャンパが正しく取り付けまたは取り外されていることを確認します。

2. F28035 controlCARDを100ピンDIMMコネクタに挿入します。

3. 12V DCのベンチ電源をTP10とTP11の間に正しい極性で接続します。

4. 400VのプログラマブルDC電源を400V入力コネクタに接続し、12V負荷を12Vコネクタに接続します（この負荷
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は基板の定格を超えないようにしてください）。

5. PCと基板の間にUSB-B/USB-Aケーブルを接続します。

注注: どの電源もオンにしないでください。

6. 基板をJTAG接続でテストするのが初めてである場合は、xds100v2-FT_Prog_v2.2.zipファイル内の
program_ftdi.batファイルを実行して、基板上のFTDIチップをプログラミングします。

7. Code Composer Studio（CCSv5以降）を起動します。

8. CCSを画面上で最大化します。

9. Welcome画面が表示された場合は閉じます。

注注: プロジェクトには、マイコンのハードウェアで実行できる実行形式出力ファイル（.out）を開発するため
に必要な、すべてのファイルとビルド・オプションが含まれています。

10. メニュー・バーで、“Project” → “Import Existing CCS/CCE Eclipse Project”の順にクリックします。

11. ..\controlSUITE\ development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\Buck_Mode
ディレクトリを選択します。

12. “Projects”タブで、Bi-dir_Buckにチェックマークが付いていることを確認します。

13. “Finish”をクリックします。

注注: このプロジェクトは、すべての必要なツール（コンパイラ、アセンブラ、リンカ）を使用してビルドを実行
します。

14. 左側の“Project”ウィンドウで、プロジェクトの左側にある“+”をクリックします。

15. メイン・ファイル内にあるビルド2の初期化コードを見つけます。

16. コードの内容を確認します。（このコードによって、すべての制御ブロックが設定、初期化され、制御フロー内で
接続されます。）

17. Bi-dir-Settings.hファイルで、段階的ビルド・オプションとして2を選択します。

注注: 以前に別のオプションをビルドした場合は、次の手順に従います。

1. プロジェクト名を右クリックします。

2. “Clean Project”をクリックします。

3. “Project” → “Build All”の順にクリックします。

4. ビルド・ウィンドウでツールが実行されるのを確認します。

18. 12V DCベンチ電源をオンにします。

19. “Debug”ボタンをクリックします。

注注: ビルド1のコードがコンパイルされてロードされます。

F28035ターゲット構成を作成するか、またはF28035.ccxmlファイルから構成をコピーするには、次の手順に従いま

す。

1. “Target Configurations”ウィンドウで、F28035.ccxmlを右クリックします。

2. “Debug”ウィンドウでデバイスの名前を右クリックして、デバイスを接続します。

3. “Run”→“Load”→“Load Program”の順に選択します。

4. Buck_Mode\F2803x_Flash\Bi-dir_Buck.outを選択して、コードをロードします。

注注: 右上の“CCS Debug”アイコンに、プログラムが“Debug Perspective”ビューであると表示されている
必要があります。

5. main()の先頭でプログラムを停止します。
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デデババッッググ環環境境ウウィィンンドドウウ

コードのデバッグ中に、ローカル変数およびグローバル変数を監視します。CCSのメモリ・ビューおよび監視ビュー

を使用できます。CCSでは、時間ドメインと周波数ドメインのプロットを作成できます。波形はグラフ・ウィンドウを使用

して表示できます。

1. メニュー・バーで、“View” → “Scripting console”をクリックします。

2. スクリプト・コンソールの“Open File ( )”コマンドを使用して、プロジェクト・ディレクトリから
AddWatchWindowVars.jsファイルを開きます。

これにより、“Expressions”ウィンドウの各項目が設定されます。“Expressions”ウィンドウの外観については、図

46を参照してください。

注注: いくつかの変数はメイン・コードのこの時点では初期化されておらず、不定の値が格納されています。

図図 46. 降降圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド2

注注: 監視ビューの追加の変数を確認します。

3. Gui_VfbSetを使用して、出力電圧コマンドを設定します。

ココーードドのの実実行行

1. リアルタイム・モードをイネーブルにします。

2. 監視ビューの連続的更新をイネーブルにし、連続的更新間隔を変更します。

3. ツールバーの“Run”をクリックして、コードを実行します。

4. DC出力のPSFBシステムに12V出力で約3A～6Aの電流が流れるように、適切な抵抗性負荷を適用します。

注注: TIでは、絶縁型DC電源を使用して、400VのDC入力を基板に供給することを推奨します。

5. 400V入力に390V DC電源を供給します。
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6. Gui_VfbSetコマンドを12V（Q10）に変更します。

注注: 出力電圧が12Vまで上昇を開始します。この出力電圧の上昇レートは、変数VfbSlewRateの設定に
よって変更できます。この時点で、Gui_VfbSetコマンドを変更できますが、変更結果が基板の要件を
満たすことを確認してください。

図 47 は、入力電圧が約390V、負荷が約12A（1Ω）、12V出力のときのシステム動作に対応する監視ビューを示

しています。

図図 47. 降降圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド2ののVMCモモーードド（（ラランンタタイイムム））

7. 監視ビューからSR_mode変数を0、1、または2に変更して、同期整流器の動作モードを変更します。（デフォル
トでは、同期整流器はモード2で動作します。）

8. 異なるSRモードで、消費される入力電流の変化および出力電圧の変化による影響を観測します。（出力電圧ま
たは入力電圧への影響はないはずです。）

9. 同期整流器スイッチを駆動するPWM波形をプローブします。

注注: 非常に低い負荷で動作しているときや、出力電圧が非常に低い（6V未満）ときには、SRモードを変
更しないでください。そのような場合は、デフォルトのSRモード2を使用してください。

位相は小さい間隔で増加させます。常に出力電圧を慎重に観測してください。電圧が基板の定格を
超えないようにしてください。これらの変化が基板の要件内であることを確認します。

オシロスコープを使用して、PWMゲート駆動信号、入力電圧、電流、出力電圧などの波形をプロー
ブできます。

この絶縁型DC-DCコンバータに対してこれらの高電圧および高電流をプローブする際には、安全性
に関する適切な予防措置を実施し、適切な接地要件を考慮してください。

リアルタイム・モードでマイコンを完全に停止させるには、次の手順に従います。

1. 400V DC入力をオフにし、数秒間待ちます。

2. ツールバーの“Halt”をクリックして、プロセッサを停止します。

3. をク
リックして、マイコンのリアルタイム・モードを終了します。

4. マイコンをリセットします。
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コンバータを出力インダクタ制御モード（ACMCモード）で制御するには、次の手順に従います。

1. Bi-dir-Settings.hファイルでVMC0_ACMC1を1に設定します。

注注: 以前に別のオプションをビルドした場合は、次の手順に従います。

1. プロジェクト名を右クリックします。

2. “Clean Project”をクリックします。

3. “Project” → “Build All”の順にクリックします。

4. ビルド・ウィンドウでツールが実行されるのを確認します。

2. “Target Configurations”ウィンドウで、F28035.ccxmlを右クリックします。

3. “Debug”ウィンドウでデバイスの名前を右クリックして、デバイスを接続します。

4. “Run”→“Load”→“Load Program”の順に選択します。

5. Buck_Mode\F2803x_Flash\Bi-dir_Buck.outを選択して、コードをロードします。

注注: 右上の“CCS Debug”アイコンに、プログラムが“Debug Perspective”ビューであると表示されている
必要があります。

6. main()の先頭でプログラムを停止します。

7. リアルタイム・モードをイネーブルにします。

8. 監視ビューの連続的更新をイネーブルにし、連続的更新間隔を変更します。

9. ツールバーの“Run”をクリックして、コードを実行します。

10. DC出力のPSFBシステムに2Ωの抵抗性負荷を適用します。

11. 400V入力に390V DC電源を供給します。

12. Gui_IoutSet コマンドを4A（Q12）に変更します。

注注: 出力電流は約4A、出力電圧は約8Vになります。一般に、出力インダクタ電流測定の精度は、負荷が
大きいほど高くなります。この時点で、Gui_IoutSetコマンドを変更できますが、変更結果が基板の要
件を満たすことを確認してください。

図 48 に、出力の負荷が2Ωで入力電圧が約390Vのときの、6A電流コマンドに対するシステム動作の監視

ビューを示します。

図図 48. 降降圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド2ののACMCモモーードド（（ラランンタタイイムム））
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リアルタイム・モードでマイコンを完全に停止させるには、次の手順に従います。

1. 400V DC入力をオフにし、数秒間待ちます。

2. ツールバーの“Halt”をクリックして、プロセッサを停止します。

3. をクリックして、マイコンのリアルタイム・モードを終了します。

4. マイコンをリセットします。

5. CCSを閉じます。

7 昇昇圧圧モモーードド（（ププッッシシュュププルル）） – 機機能能説説明明

7.1 電電圧圧モモーードド制制御御

図 49に示すように、昇圧モードでのVMCモードの実装は、降圧モードでのVMCモードの実装と同様に行われま

す。この動作モードでの主な違いは、位相シフト制御される降圧モードのコンバータとは異なり、コンバータがデュー

ティ制御コンバータとして動作することです。

昇圧モードでは降圧モード出力インダクタを電流源として使用できるため、このトポロジは電流給電のプッシュプル・

コンバータとして動作できます。各プッシュプル・スイッチは、50%を超えるデューティ・サイクルのPWM信号で駆動

され、それぞれ互いに180度位相がずれています。このデューティ・サイクルは、高電圧側に転送されるエネルギー

の量を規定します。コントローラは、2つのプッシュプル・スイッチを駆動するPWM信号のデューティ・サイクルを直接

制御してこのエネルギー転送を制御することにより、出力のレギュレーションを実現します。HV側のフルブリッジ・ス

イッチはオフに保持し、それらのボディ・ダイオードを整流に使用することができます。この実装では、フルブリッジ・

スイッチは、昇圧モードでの同期整流に使用します。図 51に、これらの波形を示します。

図図 49. VMCののブブロロッックク図図
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7.2 出出力力電電流流のの平平均均電電流流モモーードド制制御御（（ACMC））

降圧モードでのACMC実装と同様に、この実装では、1つの平均電流ループを使用して高電圧バッテリまたはバス

の充電電流を制御します（定電流充電）。ACMC実装は、波形生成および電源段制御については 7.1のVMC実装

と同様です。図 50に示すように、コントローラでは、2つのプッシュプル・スイッチを駆動するPWM信号を直接駆動

し、そのデューティ・サイクルを制御します。VMCモードと同様に、コントローラはこのデューティ・サイクルを直接制

御してエネルギー転送を制御することにより、出力のレギュレーションを行います。

図図 50. ACMCののブブロロッックク図図
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図 51 に、昇圧モード動作中のさまざまな波形を示します。

図図 51. 昇昇圧圧モモーードドのの波波形形
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8 昇昇圧圧モモーードド – ソソフフトトウウェェアアのの概概要要

8.1 ソソフフトトウウェェアア制制御御フフロローー

Bi-dir_Boostプロジェクトでは、Cバックグラウンド/ASM-ISRフレームワークを使用します。このプロジェクトは、アプリ

ケーションのメインのサポート・プログラムとしてCコードを使用し、すべてのシステム管理タスク、意思決定、インテリ

ジェンス、およびホストとのやり取りを実行します。アセンブリ・コードは、すべての重要な制御コードを実行するISR
のみに厳密に制限されています。これには一般に、ADCの読み取り、制御用の計算、およびPWMとDACの更新が

含まれます。

図 52 に、このプロジェクトの全般的なソフトウェア・フローを示します。

図図 52. 昇昇圧圧モモーードドののソソフフトトウウェェアア・・フフロローー

このプロジェクトで使用される主要なフレームワークCファイルを以下に示します。

• Bi-dir-Main.c – このファイルはアプリケーションを初期化、実行、および管理します。

• Bi-dir-DevInit_F2803x.c – このファイルは、マイコンを1回のみ初期化および構成し、クロック、PLL、GPIOの設

定などの機能を含みます。

ISRは、以下のファイルから構成されます。

• Bi-dir-DPL-ISR.asm – このファイルは、時間が重要となる制御タイプ・コードをすべて含んでいます。このファイ

ルには初期化セクション（1回実行）とランタイム・セクション（PWMスイッチング周波数で実行）が含まれていま

す。

Power Libraryの関数（モジュール）は、このフレームワークから呼び出されます。
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ライブラリ・モジュールにはCコンポーネントとアセンブリ・コンポーネントの両方が含まれる場合があります。表 5に、

このプロジェクトで使用されるライブラリ・モジュールのCモジュール名および対応するアセンブリ・モジュール名を示

します。

表表 5. ラライイブブララリリ・・モモジジュューールル

C構構成成関関数数 ASM初初期期化化ママククロロ ASMラランンタタイイムム・・ママククロロ

DAC_Cnf.c
ADC_SOC_Cnf.c ADCDRV_4CH_INIT m,n,p,q ADCDRV_4CH m,n,p,q
PWM_PSFB_VMC_SR_Cnf.c PWMDRV_BIDIR_BOOST_INIT m,n,p,q PWMDRV_BIDIR_BOOST m,n,p,q

CNTL_2P2Z_INIT n CNTL_2P2Z n

図 53 に制御ブロックを示します。

図図 53. ソソフフトトウウェェアア・・ブブロロッックク

図 53では、濃い青色のブロックがC2000マイコン上のハードウェア・モジュールを表しています。青色のブロックは、

これらのモジュール用のソフトウェア・ドライバです。黄色のブロックは、制御ループ用のコントローラ・ブロックです。

ここでは2極/2ゼロのコントローラを使用していますが、PI/PIDや3極/3ゼロなど、このアプリケーションに実装可能な

他の種類のコントローラも使用できます。図 40に示すように、このようなモジュール型のライブラリ構造によって、シス

テム全体のソフトウェアの流れが見やすく、理解しやすくなっています。また、この構造により、各種の機能の使用、

追加、削除が簡単になります。このプロジェクトでは、段階的ビルドのアプローチを実装することで、これらのメリットを

示しており、これについては次のセクションでさらに詳しく説明します。システムは、1つの電圧/電流帰還ループに

よって制御されます。
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図 54 には、制御ブロックの実行レートも示されています。たとえば、電圧コントローラは100kHzのレート（PWM
スイッチング周波数と同じ）で実行されます。

図図 54. 制制御御フフロローー

センスされた出力電圧/電流（Adc_Vhv/Adc_Ihv）は、電圧/電流コントローラの電圧または電流リファレンス・コマンド

（Vref/Iref）と比較されます。コントローラ出力によって、2つのプッシュプル・スイッチを駆動するPWM信号のデュー

ティ・サイクルを直接制御します。このデューティ・サイクルは、高電圧側の同期整流に対するフルブリッジの2つのレ

グ間の位相オーバーラップの大きさを規定します。dbA_legおよびdbB_legの値によって、フルブリッジ・スイッチに

適切なターンオン遅延が提供されます。

8.2 段段階階的的ビビルルドド

このプロジェクトは、2つの段階的ビルドに分かれています。これによって、基板およびソフトウェアについて理解し習

熟しやすくなります。また、このアプローチは、基板のデバッグやテストにも適しています。表 6に、ビルド・オプション

を示します。特定のビルド・オプションを選択するには、表 6に示されるように、Bi-dir-Settings.hファイルにあるマク

ロINCR_BUILDを対応するビルド選択に設定します。ビルド・オプションを選択したら、rebuild-allコンパイラ・オプ

ションを選択して、プロジェクト全体をコンパイルします。各ビルド・オプションの実行の詳細については、 9を参照し

てください。

表表 6. 降降圧圧モモーードドのの段段階階的的ビビルルドド・・オオププシショョンン

オオププシショョンン 説説明明

INCR_BUILD = 1 ADC帰還を使用した開ループ昇圧駆動（PWM駆動回路およびセンシング回路をチェック）

INCR_BUILD = 2 閉ループ（VMC/ACMCモードでの完全な昇圧モード）
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9 昇昇圧圧モモーードド – 段段階階的的ビビルルドドのの実実行行手手順順

メイン・ソース・ファイル、ISRアセンブリ・ファイル、およびシステムを起動するCフレームワーク用のプロジェクト・ファ

イルは、次のディレクトリに格納されています（最新バージョンのソフトウェア・パッケージを使用してください）。

• ..\controlSUITE\development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\Boost_Mode

図 7 に、昇圧モードのテスト用のハードウェア構成を示します。

WARNING
基基板板上上ににはは高高電電圧圧がが印印加加さされれてていいまますす。。ララボボ環環境境でで経経験験をを積積んんだだ電電源源技技術術
者者ののみみがが基基板板をを取取りり扱扱うう必必要要ががあありりまますす。。ここのの基基板板をを安安全全にに評評価価すするるににはは、、適適
切切なな絶絶縁縁型型のの高高電電圧圧DC電電源源をを使使用用ししててくくだだささいい。。基基板板ににDC電電源源をを印印加加すするる
前前にに、、電電圧圧計計おおよよびび適適切切なな抵抵抗抗性性負負荷荷ままたたはは電電子子負負荷荷をを出出力力にに接接続続すするる必必
要要ががあありりまますす。。電電源源がが印印加加さされれてていいるる間間はは、、基基板板にに触触れれなないいででくくだだささいい。。

Boost_Modeソフトウェア内のサンプルをビルドして実行する方法の手順を以下に示します。

9.1 ビビルルドド1: ADC帰帰還還をを使使用用ししたた開開ルルーーププ・・チチェェッックク

目目的的

このビルドの目的は、システムの開ループ動作を評価し、PWMおよびADCドライバ・モジュールを検証し、基板上

のMOSFETドライバ回路とセンシング回路を検証し、CCSの動作に習熟することです。このシステムは開ループで

動作しているため、ADCでの測定値はこのビルドでの計測の目的にのみ使用されます。このセクションでは、プロ

ジェクトのビルドと実行に必要な手順について説明します。

概概要要

ビルド1のソフトウェアは、電流給電プッシュプルPWMドライバ・モジュールをすばやく評価できるように構成されて

います。これは、オシロスコープで出力波形を表示し、CCS上でデューティ・コマンドを対話的に調整しながら、出力

電圧に対するデューティ・サイクル変化の影響を観測することで行います。ADCドライバ・モジュールの評価は、

ADCでサンプリングされたデータを監視ビューで表示することによって行います。
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PWMおよびADCドライバのマクロのインスタンス化は、 8の_DPL_ISRの内部で実行されます。図 55に、このビルド

で使用される各ブロックを示します。ePWM1AおよびePWM1BはそれぞれQ2およびQ3フルブリッジ・スイッチを駆

動し、ePWM2AおよびePWM2BはそれぞれQ1およびQ4フルブリッジ・スイッチを駆動します。ePWM4Aおよび

ePWM4Bは、それぞれQ6およびQ5プッシュプル・スイッチを駆動します。

図図 55. ビビルルドド1ののソソフフトトウウェェアア・・ブブロロッックク

これらのPWM信号は、100kHzの周波数（つまり、10µsの周期）で生成する必要があります。マイコンが60MHzで動

作している場合、ePWM1、ePWM2、またはePWM4の時間ベース・カウンタの1カウントは16.667nsに対応します。

ePWM1、ePWM2、またはePWM4の時間ベース・カウンタの1カウントが16.667nsに対応するということは、10µs
のPWM周期が時間ベース・カウンタ（TBCNT1、TBCNT2、およびTBCNT4）の600カウントに相当することを意味し

ます。ePWM1、ePWM2、およびePWM4モジュールはアップダウン・カウント・モードで動作するよう構成されていま

す。ePWM1AとePWM1Bの出力は50%のデューティ・サイクルで動作し、相補的になっています。同様に、

ePWM2AとePWM2Bの出力も50%のデューティ・サイクルで動作し、相補的になっています。ePWM4Aおよび

ePWM4Bは50%を超えるデューティ・サイクルで動作し、互いに位相が180度ずれています。図 51に、これらの

PWM波形を示します。

2つのプッシュプル・スイッチを駆動するPWM信号間のオーバーラップが終了すると、対応する対角線上のフルブ

リッジ・スイッチ・ペアがオンになります。Q6がオフの間は、Q2とQ4を駆動するPWM信号がオーバーラップします。

Q5がオフの間は、Q1とQ3を駆動するPWM信号がオーバーラップします。

アセンブリISRは、ePWM1のZRO（TBCNT1 = 0）イベントによってトリガされます。このISRで、制御ドライバのマク

ロが実行され、プッシュプルのデューティ・コマンドが更新されます。ADCドライバ・モジュールを使用して12ビットの

ADC結果を読み取り、それをQ24値に変換します。各PWMサイクル中に、PWM2 SOCA（変換Aの開始）によって

5回のADC変換がトリガされます。
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保保護護

このプロジェクトで使用されるシャットダウン・メカニズムでは、オンチップのアナログ・コンパレータ1を使用して、トラ

ンスの高電圧巻線電流に対する過電流保護を実装しています。LVインダクタ電流の過電流保護は、オンチップ・ア

ナログ・コンパレータ2を使用して実装されます。基準トリップ・レベルは内部の10ビットDACを使用して設定され、こ

れらのコンパレータの反転端子に供給されます。コンパレータの出力は、センスされた電流が設定制限値を上回る

ときにePWM1、ePWM2、およびePWM4にワンショットのトリップ・アクションを生成するよう構成されています。LV
側とHV側両方の過電圧保護は、低速ステートマシン・タスクA1内部のソフトウェアに実装されています。過電圧状

態が検出されると、ePWM1、ePWM2、およびePWM4でワンショット・トリップ・アクションが開始されます。

C2000デバイスのトリップ・メカニズムの柔軟性により、異なるトリップ・イベントに対して異なるアクションを実行するこ

とが可能になっています。このプロジェクトでは、電源段を保護するために、ePWM1A、ePWM1B、ePWM2A、
ePWM2B、ePWM4A、およびePWM4Bが直ちにLowになります。これらの出力は、デバイスのリセットが実行される

までの間、Lowに保持されます。

9.1.1 手手順順

CCSをを起起動動しし、、ププロロジジェェククトトをを開開くく

このビルドをすばやく実行するには、次の手順に従います。

1. 2で示したとおりに、基板上のすべてのジャンパが正しく取り付けまたは取り外されていることを確認します。

2. F28035 controlCARDを100ピンDIMMコネクタに挿入します。

3. 12V DCのベンチ電源をTP10とTP11の間に正しい極性で接続します。

4. 400VのプログラマブルDC電源を400V入力コネクタに接続し、12V負荷を12Vコネクタに接続します（この負荷
は基板の定格を超えないようにしてください）。

5. PCと基板の間にUSB-B/USB-Aケーブルを接続します。

注注: この時点では、どの電源もオンにしないでください。

6. 基板をJTAG接続でテストするのが初めてである場合は、xds100v2-FT_Prog_v2.2.zipファイル内の
program_ftdi.batファイルを実行して、基板上のFTDIチップをプログラミングします。

7. Code Composer Studio（CCSv5以降）を起動します。

8. CCSを画面上で最大化します。

9. Welcome画面が表示された場合は閉じます。

注注: プロジェクトには、マイコンのハードウェアで実行できる実行形式出力ファイル（.out）を開発するため
に必要な、すべてのファイルとビルド・オプションが含まれています。

10. メニュー・バーで、“Project” → “Import Existing CCS/CCE Eclipse Project”の順にクリックします。

11. ..\controlSUITE\ development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\Boost_Mode
ディレクトリを選択します。

12. “Projects”タブで、Bi-dir_Boostにチェックマークが付いていることを確認します。

13. “Finish”をクリックします。

注注: このプロジェクトは、すべての必要なツール（コンパイラ、アセンブラ、リンカ）を使用してビルドを実行
します。
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14. 左側の“Project”ウィンドウで、プロジェクトの左側にある“+”をクリックします。図 56を参照してください。

図図 56. 昇昇圧圧モモーードドののCCSププロロジジェェククトト・・ウウィィンンドドウウ

デデババイイススのの初初期期化化、、メメイインン、、おおよよびびISRフファァイイルル

注注: ソース・ファイルには一切変更を加えないでください。

1. Bi-dir-DevInit_F2803x.cをダブルクリックします。

2. システム・クロック、ペリフェラル・クロックのプリスケール、およびペリフェラル・クロックのイネーブルが設定されて
いることを確認します。

3. 共有GPIOピンが設定されていることを確認します。

4. Bi-dir-Main.cをダブルクリックします。

5. DeviceInit()関数の呼び出し、各段階的ビルド・オプションのコード、ISR初期化、およびバックグラウンドfor(;;)
ループを表示します。

6. メイン・ファイル内にあるビルド1のコードを見つけます。
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7. コードの内容を確認します。

注注: これは、制御フロー内でADCDRV_4CHブロックを接続し、初期化するコードです。

8. Bi-dir-DPL-ISR.asmをダブルクリックします。

注注: 初期化およびランタイム用のPWMおよびADCドライバ・マクロのインスタンス化は、それぞれ_DPL_
Initおよび_DPL_ISRセクションで実行されます。確認を終えたファイルは閉じてかまいません。

ププロロジジェェククトトののビビルルドドととロローードド

1. Bi-dir-Settings.hファイルで、段階的ビルド・オプションとして1を選択します。

注注: 以前に別のオプションをビルドした場合は、プロジェクト名を右クリックして、“Clean Project”をクリック
します。

2. “Project” → “Build All”の順にクリックします。

3. 12V DCベンチ電源をオンにします。

4. “Debug”ボタンをクリックします。

注注: ビルド1のコードがコンパイルされてロードされます。

F28035ターゲット構成を作成するか、またはF28035.ccxmlファイルから構成をコピーするには、次の手順に従いま

す。

1. “Target Configurations”ウィンドウで、F28035.ccxmlを右クリックします。

2. “Debug”ウィンドウでデバイスの名前を右クリックして、デバイスを接続します。

3. “Run”→“Load”→“Load Program”の順に選択します。

4. Boost_Mode\F2803x_Flash\Bi-dir_Boost.outを選択して、コードをロードします。

注注: 右上の“CCS Debug”アイコンに、プログラムが“Debug Perspective”ビューであると表示されている
必要があります。

5. main()の先頭でプログラムを停止します。

デデババッッググ環環境境ウウィィンンドドウウ

コードのデバッグ中に、ローカル変数およびグローバル変数を監視します。CCSのメモリ・ビューおよび監視ビュー

を使用できます。CCSでは、時間ドメインと周波数ドメインのプロットを作成できます。波形はグラフ・ウィンドウを使用

して表示できます。

1. メニュー・バーで、“View” → “Scripting console”をクリックします。

2. スクリプト・コンソールの“Open File ( )”コマンドを使用して、プロジェクト・ディレクトリから
AddWatchWindowVars.jsファイルを開きます。

これにより、“Expressions”ウィンドウの各項目が設定されます。“Expressions”ウィンドウの外観については、図 43
を参照してください。

いくつかの変数はメイン・コードのこの時点では初期化されておらず、不定の値が格納されています。
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OC_FaultFlgがセットされている場合は、過電流状態によってPWM出力がシャットダウンされることを示しています。

PWM出力は、デバイスがリセットされるまでこの状態に保持されます。Ihv_trip変数はオンチップ・コンパレータ1
に対する内部10ビットDAC基準レベル（HV巻線の過電流スレッショルド）を設定し、Ilv_trip変数はオンチップ・コン

パレータ2に対する内部10ビットDAC基準レベル（LVインダクタの過電流スレッショルド）を設定します。これらは

Q15値です。を参照してください。

図図 57. 昇昇圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド1

リリアアルルタタイイムム・・エエミミュュレレーーシショョンンのの使使用用

リアルタイム・エミュレーションは、マイコンの動作中にCCS内のウィンドウを最大10Hzのレートで更新できるようにす

る特別なエミュレーション機能です。このエミュレーションにより、グラフや監視ビューが更新され、また、マイコンの動

作に影響を与える監視またはメモリ・ウィンドウ内の値を変更することができます。このエミュレーションは、制御パラ

メータをその場で調整する際に便利です。

リアルタイム・モードをイネーブルにするには、次の手順に従います。

1. 水平ツールバー上のボタンにマウス・ポインタを置きます。

2. をク
リックします。

注注: メッセージ・ボックスが表示されたら、“YES”を選択して、デバッグ・イベントをイネーブルにします。こ
れにより、ステータス・レジスタ1（ST1）のビット1（DGBMビット）が0に設定されます。

DGBMは、デバッグ・イネーブル・マスク・ビットです。DGBMビットが0に設定されているときは、メモリ
およびレジスタの値をホスト・プロセッサに渡して、デバッガ・ウィンドウを更新できます。

開いているまたは更新中のウィンドウや変数の数が多すぎるときには、連続的に更新を実行すると、エミュレーショ

ン・リンクの帯域幅が限られているために、更新頻度が遅くなる場合があります。

“Expressions”ウィンドウの更新レートを下げるには、次の手順に従います。

1. “Expressions”ウィンドウで を右クリックします。

2. “Continuous Refresh Interval…”を選択します。
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3. 連続更新間隔の値を変更します。（通常、これらのテストには、1000msのレートで十分です。）

4. 監視ビューの をクリックします。
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ココーードドのの実実行行

1. ツールバーの“Run”をクリックします。

2. 監視ビューでstart_converter変数が0に設定されていることを確認します。

3. BoostDutyが0.0（Q24）に設定されていることを確認します。

注注: この変数は、PWMDRV_BIDIR_BOOSTモジュールへのデューティ・コマンドを規定します。

4. HV（400V）DC出力に2kΩの抵抗性負荷を適用します。

注注: TIでは、絶縁型DC電源を使用して、400V DCおよび12V入力を供給することを推奨します。

5. 400V DC電源を100V DC出力に設定します。

6. この電源をオンにします。

7. start_converterを1に設定します。（400V DCバス電圧が約150Vまで上昇し、400V DC電源電流は0まで減少
します。）

8. 監視ビューでBoostDutyを0.1（Q24）に設定して、デューティ・コマンドを増加させます。

9. 出力電圧が上昇して昇圧動作が行われるのを観測します。

注注: 電圧が基板の定格を超えないようにしてください。

特定のBoostDuty値で動作しているときには、負荷を急激に減少させると出力電圧が急上昇する場
合があります。ビルド1での動作時には、負荷や入力電圧を急に変化させたりBoostDutyコマンドを大
幅に増加させたりしないようにしてください。

10. 異なるBoostDuty値に対して、監視ビューで異なるADC結果を観測します。

図 58 は、LV入力が12V、HV出力の負荷が2kΩのときの、約250VのHV電圧出力を得る0.35（Q24）の
BoostDutyコマンドに対するシステム動作の監視ビューを示しています。（12Vコネクタには100Ωの負荷も接続

されています。）

図図 58. 昇昇圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド1（（ラランンタタイイムム））
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11. いくつかの異なるBoostDuty値を試します。

12. ADC結果を観測します。

注注: 位相は小さい間隔で増加させます。常に出力電圧を慎重に観測してください。電圧が基板の定格を
超えないようにしてください。

オシロスコープを使用して、PWMゲート駆動信号、入力電圧、電流、出力電圧などの波形をプロー
ブできます。

この絶縁型DC-DCコンバータに対してこれらの高電圧および高電流をプローブする際には、安全性
に関する適切な予防措置を実施し、適切な接地要件を考慮してください。

リアルタイム・モードでマイコンを停止させるには、次の手順に従います。

1. 400V DC入力をオフにし、数秒間待ちます。

2. ツールバーの“Halt”をクリックして、プロセッサを停止します。

3. をクリックして、マイコンのリアルタイム・モードを終了します。

4. マイコンをリセットします。
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9.2 ビビルルドド2：： 閉閉電電圧圧ルルーーププ

目目的的

このビルドの目的は、CCS環境から完全なプッシュプル・プロジェクトの動作を検証することです。

概概要要

図 59 に、このビルドの各ソフトウェア・ブロックを示します。PWMおよびADCドライバ・ブロックは、この章のビルド1
の場合と同様に使用されます。電圧または電流ループには、2極/2ゼロのコントローラを使用します。アプリケーショ

ンの制御ループ要件に応じて、PI、3極/3ゼロなど、他のコントローラ・ブロックも使用できます。

図 59に示されるとおり、電圧ループ・ブロックは100kHzで実行されます。CNTL2P2Zは、IIRフィルタ構造から実現

される2次補償回路です。この機能は、すべてのペリフェラルから独立しており、CNF関数の呼び出しを必要としま

せん。

図図 59. ビビルルドド2ののソソフフトトウウェェアア・・ブブロロッックク

変更する5つの係数は、構造体CNTL_2P2Z_CoefStruct1の要素として格納されています。この構造体の他の要素

によって、コントローラの出力がクランプされます。システムで複数のループが必要な場合、CNTL_2P2Zブロックは

複数回インスタンス化することができます。各インスタンスには、それぞれ個別の係数のセットを使用できます。試行

錯誤を通して5つの係数を直接独立に操作することはほぼ不可能であり、数学的な分析や、MATLAB、Mathcad
などの支援ツールが必要となります。これらのツールは、ボード・プロットや根軌跡など、位相マージンやゲイン・

マージンを決定するための機能を提供します。
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ループ調整をシンプルに保ち、複雑な計算や分析ツールを不要にするために、TIでは、B0、B1、B2、A1、A2に対

して、より直観的な係数ゲインP、I、Dをマッピングすることで、係数選択問題の自由度を5から3へと減らしました。こ

の自由度の減少により、P、I、Dがそれぞれ独立して段階的に調整されます。これらのマッピングの式を以下に示し

ます。

http://www.tij.co.jp
http://www-s.ti.com/sc/techlit/TIDUAI7.pdf


1 2a 1 and a 0= - =

1 2 2
0 1 2 0 1 2

1 2

b b z b z b z b z bU(z)

E(z) 1 z z z

- - -

-

+ + + +

= =

- -

2 db K '=

1 p i db K ' K ' 2 K '= - + -

0 p i db K ' K ' K '= + +

0 1 2u(k) u(k 1) b e(k) b e(k 1) b e(k 2)= - + + - + -

1 2
0 1 2

1 2
1 2

b B z b zU(z)

E(z) 1 a z a z

- -

- -

+ +

=

+ +

www.tij.co.jp 昇圧モード – 段階的ビルドの実行手順

63JAJU225–September 2015

TIDUAI7 翻訳版 — 最新の英語版資料 http://www-s.ti.com/sc/techlit/TIDUAI7
Copyright © 2015, Texas Instruments Incorporated

双方向DC/DCコンバータ

補償回路ブロック（CNTL_2P2Z）は2つの極と2つのゼロを持ち、一般的なIIRフィルタ構造に基づいています。この

ブロックには、1つのリファレンス入力と1つの帰還入力があります。帰還は、VMCモードの選択時はセンスされた出

力電圧（Adc_Vhv）であり、ACMCモードの選択時はセンスされた出力電流（Adc_Ihv）です。この選択は、Bi-dir-
Settings.hファイルから実行できます。コントローラへのリファレンス入力は、モード選択に基づいて、出力電圧リファ

レンス・コマンド（Vref）のスルー・バージョン（VhvSetSlewed）、またはリファレンス出力電流コマンド（Iref）です。伝

達関数は式 8で与えられます。

(8)

PIDコントローラの再帰形式は式 9で与えられます。

(9)

ここで、式 10、式 11、式 12が成り立ちます。

(10)

(11)

(12)

また、Zドメイン伝達関数形式は式 13のようになります。

(13)

これを一般的な形式と比較すると、PIDはCNTL_2P2Z制御の特殊なケースであり、式 14が成り立つ場合です。

(14)

P、I、およびD係数は、Pgain、Igain、およびDgainです。これらのP、I、およびD係数はQ26形式で使用されます。

CCS監視ビューからの調整を単純化するために、これらの3つの係数をさらに0～999の値へと変換します（Pgain_
Gui、Igain_Gui、Dgain_Gui）。また、ループ・パラメータも、外部の数学ツール（MATLAB、Mathcadなど）から得ら

れる調整済みの値に基づいて、直接変更できます。ループ係数は、I5Q10形式の変数b2_Gui、b1_Gui、b0_Gui、
a2_Gui、a1_Guiを使用して直接変更でき、その後で、2P2Zコントローラ用に5個のQ26係数へと変換されます。

このプロジェクトでは、実行中に係数を簡単に切り替えて、両方のループ調整方法を簡単に評価できます。この切り

替えは、GUI上で2P2Z(On)/PID(Off)ボタンをクリックするか、またはCCSから監視ビュー上でpid2p2z_GUI変数を

0または1に変更することによって行えます。このプロジェクトでは、GUI環境からのPIDベースのループ調整

（pid2p2z_GUI = 0）を使用しています。pid2p2z_GUIを1に変更する前に、b2_Gui、b1_Gui、b0_Gui、a2_Gui、
およびa1_Gui変数に信頼できる係数値がプログラミングされていることを確認してください。

注注: このプロジェクトには、有効なb2_Gui、b1_Gui、b0_Gui、a2_Gui、およびa1_Guiパラメータ値が含
まれていません。TIでは、pid2p2z_GUI = 0に保持することで、デフォルトのP、I、Dベースのループ
を使用することを推奨します。

9.2.1 手手順順

ププロロジジェェククトトののビビルルドドととロローードド

構成済みの作業環境を使用してこのビルドをすばやく実行するには、次の手順に従います。

1. 2で示したとおりに、基板上のすべてのジャンパが正しく取り付けまたは取り外されていることを確認します。

2. F28035 controlCARDを100ピンDIMMコネクタに挿入します。

3. 12V DCのベンチ電源をTP10とTP11の間に正しい極性で接続します。

4. 400VのプログラマブルDC電源を400V入力コネクタに接続し、12V負荷を12Vコネクタに接続します（この負荷
は基板の定格を超えないようにしてください）。
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5. PCと基板の間にUSB-B/USB-Aケーブルを接続します。

注注: この時点では、どの電源もオンにしないでください。

6. 基板をJTAG接続でテストするのが初めてである場合は、xds100v2-FT_Prog_v2.2.zipファイル内の
program_ftdi.batファイルを実行して、基板上のFTDIチップをプログラミングします。

7. Code Composer Studio（CCSv5以降）を起動します。

8. CCSを画面上で最大化します。

9. Welcome画面が表示された場合は閉じます。

注注: プロジェクトには、マイコンのハードウェアで実行できる実行形式出力ファイル（.out）を開発するため
に必要な、すべてのファイルとビルド・オプションが含まれています。

10. メニュー・バーで、“Project” → “Import Existing CCS/CCE Eclipse Project”の順にクリックします。

11. ..\controlSUITE\ development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\Boost_Mode
ディレクトリを選択します。

12. “Projects”タブで、Bi-dir_Boostにチェックマークが付いていることを確認します。

13. “Finish”をクリックします。

注注: このプロジェクトは、すべての必要なツール（コンパイラ、アセンブラ、リンカ）を使用してビルドを実行
します。

14. 左側の“Project”ウィンドウで、プロジェクトの左側にある“+”をクリックします。

15. メイン・ファイル内にあるビルド2の初期化コードを見つけます。

16. コードの内容を確認します。（このコードによって、すべての制御ブロックが設定、初期化され、制御フロー内で
接続されます。）

17. Bi-dir-Settings.hファイルで、段階的ビルド・オプションとして2を選択します。

注注: 以前に別のオプションをビルドした場合は、次の手順に従います。

1. プロジェクト名を右クリックします。

2. “Clean Project”をクリックします。

3. “Project” → “Build All”の順にクリックします。

4. ビルド・ウィンドウでツールが実行されるのを確認します。

18. 12V DCベンチ電源をオンにします。

19. “Debug”ボタンをクリックします。

注注: ビルド1のコードがコンパイルされてロードされます。

F28035ターゲット構成を作成するか、またはF28035.ccxmlファイルから構成をコピーするには、次の手順に従いま

す。

1. “Target Configurations”ウィンドウで、F28035.ccxmlを右クリックします。

2. “Debug”ウィンドウでデバイスの名前を右クリックして、デバイスを接続します。

3. “Run”→“Load”→“Load Program”の順に選択します。

4. Boost_Mode\F2803x_Flash\Bi-dir_Boost.outを選択して、コードをロードします。
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注注: 右上の“CCS Debug”アイコンに、プログラムが“Debug Perspective”ビューであると表示されている
必要があります。

5. main()の先頭でプログラムを停止します。
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デデババッッググ環環境境ウウィィンンドドウウ

コードのデバッグ中に、ローカル変数およびグローバル変数を監視します。CCSのメモリ・ビューおよび監視ビュー

を使用できます。CCSでは、時間ドメインと周波数ドメインのプロットを作成できます。波形はグラフ・ウィンドウを使用

して表示できます。

1. メニュー・バーで、“View” → “Scripting console”をクリックします。

2. スクリプト・コンソールの“Open File ( )”コマンドを使用して、プロジェクト・ディレクトリから
AddWatchWindowVars.jsファイルを開きます。

これにより、“Expressions”ウィンドウの各項目が設定されます。“Expressions”ウィンドウの外観については、図 60
を参照してください。

いくつかの変数はメイン・コードのこの時点では初期化されておらず、不定の値が格納されています。

OC_FaultFlgがセットされている場合は、過電流状態によってPWM出力がシャットダウンされることを示しています。

PWM出力は、デバイスがリセットされるまでこの状態に保持されます。Ipri_trip変数は、オンチップ・コンパレータ1
に対する内部10ビットDACの基準レベルを設定します。これはQ15値です。図 60を参照してください。

図図 60. 昇昇圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド2

ココーードドのの実実行行

1. リアルタイム・モードをイネーブルにします。

2. 監視ビューの連続的更新をイネーブルにし、監視ビューの連続的更新を変更します。

3. ツールバーの“Run”をクリックします。

4. start_converter変数を0.0（Q24）に設定します。（この変数は電圧コマンドを規定します。）

5. DC出力のPSFBシステムに2kΩの抵抗性負荷を適用します。

注注: TIでは、絶縁型DC電源を使用して、400VのDC入力を基板に供給することを推奨します。

6. 400V DC電源を100V DC出力に設定します。

7. この電源をオンにします。

8. 12V DC電源の出力を12Vに設定します。
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9. この電源をオンにします。

10. start_converterを1に設定します。（400V DCバス電圧が約150Vまで上昇し、400V DC電源は0まで減少しま
す。）

11. 監視ビューでGui_VhvSetの値を200Vに設定して、電圧コマンドを増加させます。（昇圧動作が行われ、出力
電圧は設定されたコマンドに従います。）

12. 出力電圧の上昇を観測します。

注注: 出力電圧が基板の定格を超えないようにしてください。

Gui_VhvSetコマンドは、400V DCの電源電圧設定を下回らないようにしてください。

13. 異なるGui_VhvSet値に対して、監視ビューで異なるADC結果を観測します。（この値が変更されるごとに、出力
電圧はこの新しい値へと上昇または下降します。VhvSlewRateを変更することで、出力電圧の上昇または下降
レートを変更します。）

図 61 は、入力電圧が12V、負荷が約2Ωのときの225Vでのシステム動作に対応する監視ビューを示していま

す。

図図 61. 昇昇圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド2ののVMCモモーードド（（ラランンタタイイムム））
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図 62 は、入力電圧が12V、負荷が約2kΩのときの325V出力でのシステム動作に対応する監視ビューを示して

います。（12Vコネクタには100Ωの負荷も接続されています。）

図図 62. 昇昇圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド2、、Vout = 325V

14. 負荷を変化させたときの出力電圧および入力電流への影響を観測します。（出力電圧には影響がないはずで
す。）

注注: 電圧が、このドキュメントの仕様セクションに示される基板の能力を超えないようにしてください。

15. 入力電圧（12V DC電源）の変化による影響を観測します。

注注: 位相は小さい間隔で増加させます。常に出力電圧を慎重に観測してください。電圧が基板の定格を
超えないようにしてください。

オシロスコープを使用して、PWMゲート駆動信号、入力電圧、電流、出力電圧などの波形をプロー
ブできます。

この絶縁型DC-DCコンバータに対してこれらの高電圧および高電流をプローブする際には、安全性
に関する適切な予防措置を実施し、適切な接地要件を考慮してください。
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リアルタイム・モードでマイコンを停止させるには、次の手順に従います。

1. 400V DC入力をオフにします。

2. 数秒間待ちます。

3. ツールバーの“Halt”をクリックして、プロセッサを停止します。

4. をクリックして、マイコンのリアルタイム・モードを終了します。

5. マイコンをリセットします。

コンバータを出力インダクタ制御モード（ACMCモード）で制御するには、次の手順に従います。

1. Bi-dir-Settings.hファイルでVMC0_ACMC1を1に設定します。

注注: 以前に別のオプションをビルドした場合は、次の手順に従います。

1. プロジェクト名を右クリックします。

2. “Clean Project”をクリックします。

3. “Project” → “Build All”の順にクリックします。

4. ビルド・ウィンドウでツールが実行されるのを確認します。

2. “Target Configurations”ウィンドウで、F28035.ccxmlを右クリックします。

3. “Debug”ウィンドウでデバイスの名前を右クリックして、デバイスを接続します。

4. “Run”→“Load”→“Load Program”の順に選択します。

5. Boost_Mode\F2803x_Flash\Bi-dir_Boost.outを選択して、コードをロードします。

注注: 右上の“CCS Debug”アイコンに、プログラムが“Debug Perspective”ビューであると表示されている
必要があります。

6. main()の先頭でプログラムを停止します。

7. リアルタイム・モードをイネーブルにします。

8. 監視ビューの連続的更新をイネーブルにし、連続的更新間隔を変更します。

9. ツールバーの“Run”をクリックして、コードを実行します。

10. start_converterを0に設定します。

11. Gui_VhvSetを0.0（Q5）に設定します。（この変数は電圧コマンドを規定します。）

12. HV（400V）DC出力に2kΩの抵抗性負荷を適用します。

13. 400V入力を100V DC出力に設定します。

14. この電源をオンにします。

15. 12V DC電源を12Vに設定します。

16. この電源をオンにします。

http://www.tij.co.jp
http://www-s.ti.com/sc/techlit/TIDUAI7.pdf


昇圧モード – 段階的ビルドの実行手順 www.tij.co.jp

70 JAJU225–September 2015

TIDUAI7 翻訳版 — 最新の英語版資料 http://www-s.ti.com/sc/techlit/TIDUAI7
Copyright © 2015, Texas Instruments Incorporated

双方向DC/DCコンバータ

17. start_converterを1に設定します。（400V DCバス電圧が約150Vまで上昇し、400V DC電源電流は0まで減少
します。）

18. 監視ウィンドウに表示されるGui_lhvの値を観測し、書き留めます（Q12）。
19. Gui_IhvSetコマンドの値を0から、手順18で書き込んだGui_lhv値の0.01（Q12）以下の値へと変更します。

CAUTION

Gui_lhvSetコマンドを増加させる幅は、1回に0.01（Q12）未満としてください。

コマンドの小さな変更でも、負荷によっては400V出力で非常に高い電圧変化につな

がる場合があります。

ACMCモードでテストする際には注意が必要です。

図 63 は、入力電圧が約11.8V、負荷が2kΩ、結果の出力が270Vのときの、0.4Aの電流コマンドに対するシス

テム動作の監視ビューを示しています。（12Vコネクタには100Ωの負荷も接続されています。）

図図 63. 昇昇圧圧モモーードドのの“Expressions”ウウィィンンドドウウ：： ビビルルドド2ののACMCモモーードド（（ラランンタタイイムム））

リアルタイム・モードでマイコンを停止させるには、次の手順に従います。

1. 400V電源（100Vに設定）をオフにし、数秒間待ちます。

2. 12V入力をオフにし、数秒間待ちます。

3. ツールバーの“Halt”をクリックして、プロセッサを停止します。

4. をクリックして、マイコンのリアルタイム・モードを終了します。

5. マイコンをリセットします。

6. CCSを閉じます。
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10 双双方方向向DC-DC（（フフルル）） – ソソフフトトウウェェアアのの概概要要

10.1 ソソフフトトウウェェアア制制御御フフロローー

この実装では、両方向への電力の流れを制御でき、ソフトウェア・コマンドに基づいて降圧モードと昇圧モードをそ

の場で切り替えることができます。降圧および昇圧変換にはVMCモードが使用されます。このプロジェクトは、降圧

モード・プロジェクトのビルド・レベル2（ 6.2を参照）と昇圧モード・プロジェクトのビルド・レベル2（ 9.2を参照）を組み

合わせたもので、さらに2つのモード間の高速でスムーズな切り替えを実現するために適切なコードを追加していま

す。

Bi-dir_Fullプロジェクトでは、Cバックグラウンド/ASM-ISRフレームワークを使用します。このフレームワークは、アプ

リケーションのメインのサポート・プログラムとしてCコードを使用し、すべてのシステム管理タスク、意思決定、インテリ

ジェンス、およびホストとのやり取りを実行します。アセンブリ・コードは、すべての重要な制御コードを実行するISR
のみに厳密に制限されています。これには一般に、ADCの読み取り、制御用の計算、およびPWMとDACの更新が

含まれます。図 64に、このプロジェクトの全般的なソフトウェア・フローを示します。

図図 64. 昇昇圧圧モモーードドののソソフフトトウウェェアア・・フフロローー

このプロジェクトの主要なフレームワークCファイルを以下に示します。

• Bi-dir-Main.c – このファイルはアプリケーションを初期化、実行、および管理します。

• Bi-dir-DevInit_F2803x.c – このファイルは、マイコンを1回のみ初期化および構成し、クロック、PLL、GPIOの設

定などの機能を含みます。

ISRは、次の1つのファイルから構成されます。

• Bi-dir-DPL-ISR.asm – このファイルは、時間が重要となる制御タイプ・コードをすべて含んでいます。このファイ

ルには初期化セクション（1回実行）とランタイム・セクション（PWMスイッチング周波数で実行）が含まれていま

す。
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Power Libraryの関数（モジュール）は、このフレームワークから呼び出されます。

ライブラリ・モジュールにはCコンポーネントとアセンブリ・コンポーネントの両方が含まれる場合があります。表 7に、

Cモジュール名および対応するアセンブリ・モジュール名を示します。

表表 7. ラライイブブララリリ・・モモジジュューールル

C構構成成関関数数 ASM初初期期化化ママククロロ ASMラランンタタイイムム・・ママククロロ

DAC_Cnf.c
ADC_SOC_Cnf.c ADCDRV_4CH_INIT m,n,p,q ADCDRV_4CH m,n,p,q
PWM_PSFB_VMC_SR_Cnf.c PWMDRV_PSFB_VMC_SR_INIT m,n,p PWMDRV_PSFB_VMC_SR m,n,p
PWM_PSFB_VMC_SR_Cnf.c PWMDRV_BIDIR_BOOST_INIT m,n,p,q PWMDRV_BIDIR_BOOST m,n,p,q

CNTL_2P2Z_INIT n CNTL_2P2Z n

図 65 に制御ブロックを示します。

図図 65. ソソフフトトウウェェアア・・ブブロロッックク
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図 66では、濃い青色のブロックがC2000マイコン上のハードウェア・モジュールを表しています。青色のブロックは、

これらのモジュール用のソフトウェア・ドライバです。黄色のブロックは、制御ループ用のコントローラ・ブロックです。

ここでは2極/2ゼロのコントローラを使用していますが、PI/PIDや3極/3ゼロなど、このアプリケーションに適切に実装

可能な他の種類のコントローラも使用できます。図 66に示すように、このようなモジュール型のライブラリ構造によっ

て、システム全体のソフトウェアの流れが見やすく、理解しやすくなっています。また、この構造により、各種の機能

の使用、追加、削除が簡単になります。

図図 66. 制制御御フフロローー
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システムは、降圧モードと昇圧モードの両方で1つの電圧帰還ループによって制御されます。システムが一方の

モードのときは、そのモードでの動作に必要なソフトウェア・ブロックだけが実行され、他方のモードにのみ必要なブ

ロックは実行されません。図 66には、制御ブロックの実行レートも示されています。たとえば、電圧コントローラは

100kHzのレート（PWMスイッチング周波数と同じ）で実行されます。図 66で実装されている制御について次に説明

します。

センスされた出力電圧（Adc_Vhv/Adc_Vlv）は、電圧コントローラの電圧リファレンスコマンドのスルー・バージョン

（VhvSetSlewed/VlvSetSlewed）と比較されます。コントローラの出力によって、昇圧モードでは2つのプッシュプ

ル・スイッチを駆動するPWM信号のデューティ・サイクルを直接制御し、降圧モードではフルブリッジ・スイッチを駆

動するPWM信号間の位相シフトを直接制御します。これらのPWMドライバ・モジュールは、両方のモードで同期整

流器スイッチも駆動します。

モモーードド遷遷移移

2つのモード間で高速でシームレスな遷移を実現することが重要です。これらの遷移は、ステートマシン・タスクA3
内のモード遷移コードによって実現されます。（変数Buck0_Boost1を1に設定して）降圧から昇圧へのモード遷移

が開始されると、モード遷移コードによって降圧モード・シャットダウン・ルーチンが実行され、出力電圧コマンド（Gui
_VhvSet）をHVバス上の前の電圧（Gui_Vhv）よりも約4V高い値に設定した状態で、コンバータが昇圧モードで起

動します。同様に、（変数Buck0_Boost1を0に設定して）昇圧から降圧へのモード遷移が開始されると、モード遷移

コードによって昇圧モード・シャットダウン・ルーチンが実行され、出力電圧コマンド（Gui_VlvSet）をLVバス上の前

の電圧（Gui_Vlv）よりも約0.5V高い値に設定した状態で、コンバータが降圧モードで起動します。

保保護護

このプロジェクトのシャットダウン・メカニズムでは、オンチップのアナログ・コンパレータ1を使用して、トランスの高電

圧巻線電流に対する過電流保護を実装しています。LVインダクタ電流の過電流保護は、オンチップ・アナログ・コン

パレータ2を使用して実装されます。基準トリップ・レベルは内部の10ビットDACを使用して設定され、これらのコン

パレータの反転端子に供給されます。コンパレータの出力は、センスされた電流が設定制限値を上回るときに

ePWM1、ePWM2、およびePWM4にワンショットのトリップ・アクションを生成するよう構成されています。LV側とHV
側両方の過電圧保護および低電圧保護は、低速ステートマシン・タスクA1内部のソフトウェアに実装されています。

過電圧または低電圧状態が検出されると、ePWM1、ePWM2、およびePWM4でワンショット・トリップ・アクションが

開始されます。C2000デバイスのトリップ・メカニズムの柔軟性により、異なるトリップ・イベントに対して異なるアクショ

ンを実行することが可能になっています。このプロジェクトでは、電源段を保護するために、ePWM1A、ePWM1B、
ePWM2A、ePWM2B、ePWM4A、およびePWM4Bが直ちにLowになります。これらの出力は、デバイスのリセット

が実行されるまでこの状態に保持されます。
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11 双双方方向向DC-DC（（フフルル）） – 手手順順

メイン・ソース・ファイル、ISRアセンブリ・ファイル、およびシステムを起動するCフレームワーク用のプロジェクト・ファ

イルは、次のディレクトリに格納されています（最新バージョンのソフトウェア・パッケージを使用してください）。

..\controlSUITE\development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\Bi_Directional_F
ull

図 7 に、これらのテスト用のハードウェア構成を示します。

WARNING
基基板板上上ににはは高高電電圧圧がが印印加加さされれてていいまますす。。ララボボ環環境境でで経経験験をを積積んんだだ電電源源技技術術
者者ののみみがが基基板板をを取取りり扱扱うう必必要要ががあありりまますす。。ここのの基基板板をを安安全全にに評評価価すするるににはは、、適適
切切なな絶絶縁縁型型のの高高電電圧圧DC電電源源をを使使用用ししててくくだだささいい。。基基板板ににDC電電源源をを印印加加すするる
前前にに、、電電圧圧計計おおよよびび適適切切なな抵抵抗抗性性負負荷荷ままたたはは電電子子負負荷荷をを出出力力にに接接続続すするる必必
要要ががあありりまますす。。電電源源がが印印加加さされれてていいるる間間はは、、基基板板にに触触れれなないいででくくだだささいい。。

Bi_Directional_Fullソフトウェア内のサンプルをビルドして実行する方法の手順を以下に示します。

目目的的

このプロジェクトの目的は、このシステムの双方向動作、および降圧および昇圧動作モード間でのすばやい遷移に

ついて評価することです。このセクションでは、プロジェクトのビルドと実行の手順について説明します。

概概要要

図 66 に、このプロジェクトの各ソフトウェア・ブロックを示します。降圧および昇圧モード制御ブロックは、 6.2および

9.2と同様に使用されます。電圧ループには、2極/2ゼロのコントローラを使用します。アプリケーションの制御ルー

プ要件に応じて、PI、3極/3ゼロなど、他のコントローラ・ブロックも使用できます。図 66に示されるとおり、すべてのソ

フトウェア・ブロックは100kHzで実行されます。

ループ調整をシンプルに保ち、複雑な計算や分析ツールを不要にするために、B0、B1、B2、A1、A2に対して、より

直観的な係数ゲインP、I、Dをマッピングすることで、係数選択問題の自由度を5から3へと減らしました。

これらのP、I、D係数は、昇圧モードではPgainhv、Igainhv、Dgainhv、降圧モードではPgainlv、Igainlv、Dgainlv
です。これらのP、I、およびD係数はQ26形式で使用されます。CCS監視ビューからの調整を単純化するために、こ

れらの3つの係数をさらに0～999の値へと変換します（Pgainhv_Gui、Igainhv_Gui、Dgainhv_Gui、Pgainlv_Gui、
Igainlv_Gui、Dgainlv_Gui）。また、ループ・パラメータも、外部の数学ツール（MATLAB、Mathcadなど）から得られ

る調整済みの値に基づいて、直接変更できます。ループ係数は変数b2hv_Gui、b1hv_Gui、b0hv_Gui、a2hv_
Gui、a1hv_Gui、b2lv_Gui、b1lv_Gui、b0lv_Gui、a2lv_Gui、a1lv_GuiをI5Q10形式で使用することにより、直接変

更できます。これらはさらに、各2P2Zコントローラに対する5個のQ26係数に変換されます。

このプロジェクトでは、実行中に係数を簡単に切り替えて、両方のループ調整方法を簡単に評価できます。実行中

に係数を切り替えるには、CCSから監視ビューでpid2p2zhv_GUIおよびpid2p2zlv_GUI変数を0または1に変更し

ます。このプロジェクトでは、GUI環境からのPIDベースのループ調整を使用しています。pid2p2zhv_GUIまたは

pid2p2zlv_GUI変数を1に変更する前に、b2hv_Gui、b1hv_Gui、b0hv_Gui、a2hv_Gui、a1hv_Gui、b2lv_Gui、
b1lv_Gui、b0lv_Gui、a2lv_Gui、a1lv_Gui変数に信頼できる係数値がプログラミングされていることを確認してくだ

さい。
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注注: このプロジェクトには、有効なb2hv_Gui、b1hv_Gui、b0hv_Gui、a2hv_Gui、a1hv_Gui、b2lv_Gui、
b1lv_Gui、b0lv_Gui、a2lv_Gui、a1lv_Guiパラメータ値が含まれていません。TIでは、pid2p2zhv_
GUI = 0およびpid2p2zlv_GUI = 0に保持することで、デフォルトのP、I、Dベースのループを使用す
ることを推奨します。

11.1 手手順順

CCSをを起起動動しし、、ププロロジジェェククトトをを開開くく

このビルドをすばやく実行するには、次の手順に従います。

1. 2で示したとおりに、基板上のすべてのジャンパが正しく取り付けまたは取り外されていることを確認します。

2. F28035 controlCARDを100ピンDIMMコネクタに挿入します。

3. 12V DCのベンチ電源をTP10とTP11の間に正しい極性で接続します。

4. 400VのプログラマブルDC電源を400V入力コネクタに接続し、12V負荷を12Vコネクタに接続します（この負荷
は基板の定格を超えないようにしてください）。

5. PCと基板の間にUSB-B/USB-Aケーブルを接続します。

注注: この時点では、どの電源もオンにしないでください。

6. 基板をJTAG接続でテストするのが初めてである場合は、xds100v2-FT_Prog_v2.2.zipファイル内の
program_ftdi.batファイルを実行して、基板上のFTDIチップをプログラミングします。

7. Code Composer Studio（CCSv5以降）を起動します。

8. CCSを画面上で最大化します。

9. Welcome画面が表示された場合は閉じます。

注注: プロジェクトには、マイコンのハードウェアで実行できる実行形式出力ファイル（.out）を開発するため
に必要な、すべてのファイルとビルド・オプションが含まれています。

10. メニュー・バーで、“Project” → “Import Existing CCS/CCE Eclipse Project”の順にクリックします。

11. ..\controlSUITE\ development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\Bi_Direction
al_Fullディレクトリを選択します。

12. “Projects”タブで、Bi-dir_Fullにチェックマークが付いていることを確認します。

13. “Finish”をクリックします。

注注: このプロジェクトは、すべての必要なツール（コンパイラ、アセンブラ、リンカ）を使用してビルドを実行
します。

http://www.tij.co.jp
http://www-s.ti.com/sc/techlit/TIDUAI7.pdf


www.tij.co.jp 双方向DC-DC（フル） – 手順

77JAJU225–September 2015

TIDUAI7 翻訳版 — 最新の英語版資料 http://www-s.ti.com/sc/techlit/TIDUAI7
Copyright © 2015, Texas Instruments Incorporated

双方向DC/DCコンバータ

14. 左側の“Project”ウィンドウで、プロジェクトの左側にある“+”をクリックします。図 67を参照してください。

図図 67. 完完全全なな双双方方向向ププロロジジェェククトトののCCSププロロジジェェククトト・・ウウィィンンドドウウ

15. メイン・ファイル内にあるビルド2の初期化コードを見つけます。

16. コードの内容を確認します。（このコードによって、すべての制御ブロックが設定、初期化され、制御フロー内で
接続されます。）

デデババイイススのの初初期期化化、、メメイインン、、おおよよびびISRフファァイイルル

注注: ソース・ファイルには一切変更を加えないでください。

1. Bi-dir-DevInit_F2803x.cをダブルクリックします。

2. システム・クロック、ペリフェラル・クロックのプリスケール、およびペリフェラル・クロックのイネーブルが設定されて
いることを確認します。

3. 共有GPIOピンが設定されていることを確認します。

4. Bi-dir-Main.cをダブルクリックします。

5. DeviceInit()関数の呼び出し、各段階的ビルド・オプションのコード、ISR初期化、およびバックグラウンドfor(;;)
ループを表示します。

6. メイン・ファイル内で、PWMDRV_PSFB_VMC_SR、PWMDRV_BIDIR_BOOST、CNTL_2P2Z1（昇圧）、
CNTL_2P2Z2（降圧）、およびADCDRV_4CHソフトウェア・ライブラリ・ブロックを制御フロー内で接続および初
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期化するコードを見つけます。

7. Bi-dir-DPL-ISR.asmファイルを開きます。

8. _DPL_Initおよび_DPL_ISRセクションに対するBi-dir-DPL-ISR.asmを調べます。

注注: PWMおよびADCドライバ・マクロのインスタンス化は、それぞれ初期化およびランタイム用に_DPL_
Initおよび_DPL_ISRセクションで実行されます。確認を終えたファイルは閉じてかまいません。

9. ファイルを閉じます。

ププロロジジェェククトトののビビルルドドととロローードド

1. Bi-dir-Settings.hファイルで、段階的ビルド・オプションとして1を選択します。

注注: 以前に別のオプションをビルドした場合は、プロジェクト名を右クリックして、“Clean Project”をクリック
します。

2. “Project” → “Build All”の順にクリックします。

3. 12V DCベンチ電源をオンにします。

4. “Debug”ボタンをクリックします。

注注: ビルド1のコードがコンパイルされてロードされます。

F28035ターゲット構成を作成するか、またはF28035.ccxmlファイルから構成をコピーするには、次の手順に従いま

す。

1. “Target Configurations”ウィンドウで、F28035.ccxmlを右クリックします。

2. “Debug”ウィンドウでデバイスの名前を右クリックして、デバイスを接続します。

3. “Run”→“Load”→“Load Program”の順に選択します。

4. ..\Bi_Directional_Full\F2803x_FLASH\Bi-dir_Full.outを選択して、コードをロードします。

注注: 右上の“CCS Debug”アイコンに、プログラムが“Debug Perspective”ビューであると表示されている
必要があります。

5. main()の先頭でプログラムを停止します。

デデババッッググ環環境境ウウィィンンドドウウ

コードのデバッグ中に、ローカル変数およびグローバル変数を監視します。CCSのメモリ・ビューおよび監視ビュー

を使用できます。CCSでは、時間ドメインと周波数ドメインのプロットを作成できます。波形はグラフ・ウィンドウを使用

して表示できます。

1. メニュー・バーで、“View” → “Scripting console”をクリックします。

2. スクリプト・コンソールの“Open File ( )”コマンドを使用して、プロジェクト・ディレクトリから
AddWatchWindowVars.jsファイルを開きます。

これにより、“Expressions”ウィンドウの各項目が設定されます。“Expressions”ウィンドウの外観については、図 68
を参照してください。

注注: いくつかの変数はメイン・コードのこの時点では初期化されておらず、不定の値が格納されています。
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OC_FaultFlgがセットされている場合は、過電流状態によってPWM出力がシャットダウンされることを示しています。

同様に、HVbus_OV、LVbus_OV、HVbus_UV、LVbus_UVは、PWM出力をシャットダウンする過電圧および低電

圧状態を示します。PWM出力は、デバイスがリセットされるまでこの状態に保持されます。Ihv_trip変数はオンチッ

プ・コンパレータ1に対する内部10ビットDAC基準レベル（HV巻線の過電流スレッショルド）を設定し、Ilv_trip変数は

オンチップ・コンパレータ2に対する内部10ビットDAC基準レベル（LVインダクタの過電流スレッショルド）を設定しま

す。これらはQ15値です。図 68を参照してください。

図図 68. 完完全全ななププロロジジェェククトトのの“Expressions”ウウィィンンドドウウ
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リリアアルルタタイイムム・・エエミミュュレレーーシショョンンのの使使用用

リアルタイム・エミュレーションは、マイコンの動作中にCCS内のウィンドウを最大10Hzのレートで更新できるようにす

る特別なエミュレーション機能です。このエミュレーションにより、グラフや監視ビューが更新され、また、マイコンの動

作に影響を与える監視またはメモリ・ウィンドウ内の値を変更することができます。このエミュレーションは、制御パラ

メータをその場で調整する際に便利です。

リアルタイム・モードをイネーブルにするには、次の手順に従います。

1. 水平ツールバー上のボタンにマウス・ポインタを置きます。

2. をク
リックします。

注注: メッセージ・ボックスが表示されたら、“YES”を選択して、デバッグ・イベントをイネーブルにします。こ
れにより、ステータス・レジスタ1（ST1）のビット1（DGBMビット）が0に設定されます。

DGBMは、デバッグ・イネーブル・マスク・ビットです。DGBMビットが0に設定されているときは、メモリ
およびレジスタの値をホスト・プロセッサに渡して、デバッガ・ウィンドウを更新できます。

開いているまたは更新中のウィンドウや変数の数が多すぎるときには、連続的に更新を実行すると、エミュレーショ

ン・リンクの帯域幅が限られているために、更新頻度が遅くなる場合があります。

“Expressions”ウィンドウの更新レートを下げるには、次の手順に従います。

1. “Expressions”ウィンドウで を右クリックします。

2. “Continuous Refresh Interval…”を選択します。

3. 連続更新間隔の値を変更します。（通常、これらのテストには、1000msのレートで十分です。）

4. 監視ビューの をクリックします。

ココーードドのの実実行行

1. ツールバーの“Run”をクリックします。

2. 監視ビューでstart_converter変数を0に設定します。

3. Buck0_Boost1を0に設定します。

4. HV（400V）コネクタに4kΩ～8kΩの抵抗性負荷を適用します。

5. LV（12V）コネクタに適切な抵抗性負荷を適用します。

注注: TIでは、絶縁型DC電源を使用して、400V DCおよび12V入力を供給することを推奨します。

6. 400V DC電源を約225V DC出力に設定します。

7. この電源をオンにします。

8. 12V DC電源を12V出力に設定します。

9. この電源をオンにします。

10. start_converterを1に設定します。

注注: これにより、降圧モードでDC-DC変換が開始されます。Gui_VlvSetコマンドは、start_converterを1
に設定する前のLV電源出力に基づき、LV電源出力よりも約0.5V高く設定されます。
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図 69 は、HV電圧が約223V、10Ω負荷で出力が12Vのときの降圧モードのシステム動作に対応する監視

ビューを示しています。HVコネクタには8kΩの負荷も接続されています。

図図 69. 完完全全ななププロロジジェェククトトのの“Expressions”ウウィィンンドドウウ（（ラランンタタイイムム）） – 降降圧圧動動作作

LV出力電圧設定コマンド（Gui_VlvSet）を変更できます。この値は、LV電源設定より低くは設定しないでくださ

い。

注注: 降圧モードで動作中は、Gui_VlvSetコマンドを12V DC電源電圧設定よりも低く設定してはなりませ
ん。

11. Buck0_Boost1を1に設定して、動作を降圧モードから昇圧モードに切り替えます。（Gui_VhvSetコマンドは、
Buck0_Boost1を1に設定する前のHV電源出力に基づき、HV電源出力よりも約4V高く設定されます。）
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図 70 は、HV電圧出力が約227V、8kΩ負荷で入力が11.6Vのときの昇圧モードのシステム動作に対応する監

視ビューを示しています。LVコネクタには100Ωの負荷も接続されています。

図図 70. 完完全全ななププロロジジェェククトトのの“Expressions”ウウィィンンドドウウ（（ラランンタタイイムム）） – 昇昇圧圧動動作作

注注: HV出力電圧設定コマンド（Gui_VhvSet）を変更できます。この値は、HV電源設定より低くは設定し
ないでください。

注注: 昇圧モードで動作中は、Gui_VhvSetコマンドを400V DC電源電圧設定よりも低く設定してはなりま
せん。

常に出力電圧を慎重に観測してください。電圧が基板の定格を超えないようにしてください。

オシロスコープを使用して、PWMゲート駆動信号、入力電圧、電流、出力電圧などの波形をプロー
ブできます。

この絶縁型DC-DCコンバータに対してこれらの高電圧および高電流をプローブする際には、安全性
に関する適切な予防措置を実施し、適切な接地要件を考慮してください。
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リアルタイム・モードでマイコンを停止させるには、次の手順に従います。

1. 400V DC入力をオフにし、数秒間待ちます。

2. ツールバーの“Halt”をクリックして、プロセッサを停止します。

3. をクリックして、マイコンのリアルタイム・モードを終了します。

4. マイコンをリセットします。
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3. Nene, H, “Implementing Advanced Control Strategies for Phase Shifted Full-Bridge DC-DC Converters

using Micro-Controllers” PCIM Europe 2011, Nuremberg, Germany.
4. Nene, H, “Digital control of a Bi-directional DC-DC Converter for Automotive Applications”, in Applied

Power Electronics Conference and Exposition, (APEC) 2013, pp. 1360–1365
5. HV Phase Shifted Full bridge Developer’s Kit (TMDSHVPSFBKIT)
6. Bi_dir_Calculations.xls – このプロジェクトの主要な計算を示すスプレッドシート：..\controlSUITE

\development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\Docs
7. HWdevPkg – この基板のハードウェア開発に関連した各種のファイルを含むフォルダ：..\controlSUITE

\development_kits\BI_DIRECTIONAL_DC_DC_400_12\v1_00_00_00\HWdevPkg

12.1 商商標標

C2000, Code Composer Studio are trademarks of Texas Instruments.
Mathcad is a registered trademark of PTC Inc.
MATLAB is a registered trademark of The MathWorks, Inc.
すべての商標および登録商標はそれぞれの所有者に帰属します。

http://www.tij.co.jp
http://www-s.ti.com/sc/techlit/TIDUAI7.pdf
http://www.ti.com/lit/pdf/SLUA560B
http://www.ti.com/lit/pdf/SLUU421A
http://www.ti.com/tool/tmdshvpsfbkit
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